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CHAPTER I 
 
 

INTRODUCTION 

 

1.1 Background:  

The flow of liquids through pipelines is a common process in industries as well as 

the households. The supply of water for household purposes involves the transport of 

water through pipes which have small diameters. In industries the water and other fluids 

supply is done through pipelines with comparatively larger diameter. The mechanics of 

the flow of fluids depends on the properties of the fluids being transported. These fluid 

properties include density, viscosity and surface tension. The mechanics of fluid flow is 

simpler when there is only one phase. Complexities in the flow are introduced when more 

than one number of phases is participating in the flow. The flow in which more than one 

phases is flowing together is known as multiphase flow. Examples of multiphase flow 

can be bubble or droplet flow, slug flow, pneumatic transport, hydrotransport or slurry 

flows. The multiphase flow of solid particles with liquids such that the presence of solid 

particles in the flow is considerable is termed slurry flow 

 Multiphase flows are complex flows and their complexity can be attributed to the 

interaction between the participating phases. Apart from this, there can be other sources 

which contribute to the complexity of the flow. These may include the physical aspects
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like transition between different flow regimes, turbulent flow and the presence of some 

disturbed interface such as surface waves on a film to name a few. In the case of slurry 

flows liquid- particle interaction and turbulent characteristics of the flow are the factors 

which require special attention. In industrial applications, along with single phase flows, 

there are many multiphase flows in the form of particles and liquid flowing together. 

Most of the pharmaceutical and petrochemical industries involve the transportation of 

slurries through pipes using different type of pumping devices. These slurries have a 

complex composition consisting of chemical particles flowing in organic or inorganic 

solutions. The methods or the processes applied in the handling of slurries should be 

effective and efficient. The current research focus is to design better sampling techniques 

for measuring these chemical slurries used for industrial purposes. This study aims at 

providing a new methodology for the analysis of complex samples under industrial 

conditions. In the current study the flow of some specific slurries has been simulated 

using a CFD commercial software package. 

1.2 Importance of computational methods:  Experimental methods have always found 

wide applications in order to visualize the flow fields and the feature which are of real 

concern. Some of the flows can be very well described using experimental methods. 

However, it could be difficult to set up a multiphase flow experiment with the necessary 

degree of control. Such situations arise, for example, in the case of the breakup of a drop 

in a turbulent flow or precise characterization of the bubble or drop size distribution. 

There are many experimental techniques that can be easily implemented for single phase 

flows while multiphase flow systems poses severe difficulties. For example, bubbly flow 

may become opaque resulting in poor visualization even at low volume fractions. The 
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clustering of particles suspended in a slurry flow depends on the small scale details which 

are difficult to be resolved through experiments. In all these situations, numerical 

simulation stands out as an important tool for the study of multiphase flow systems. 

Computation techniques may be the best tools in some conditions. These conditions may 

be attributed to the presence of forces of gravity and surface tension. In case of 

experimental techniques, these aspects may be immeasurable. In the case of multiphase 

flows, there is always a requirement of reduced descriptions for modeling which is given 

sometimes through averaged equations. Thus such reduced models are greatly benefitted 

from the computational techniques.  

 
1.3 Fluent and Gambit as CFD tools: As discussed in the preceding paragraphs 

computational methods have an edge over experimental techniques not only because of 

the ease of obtaining the end results but also because they are economical compared to 

the experimental set ups. In the present study, Fluent has been employed as the 

commercial software package in order to facilitate the analysis of chemical slurry flow 

through pipes with FTIR (Fourier transformed infrared reflectance) probes. Gambit has 

been used as the preprocessor used to construct and mesh the pipe and probe assembly. 

The meshed geometry is exported to Fluent for the actual analysis. The pipe Reynolds 

number for the flow is of the order of 100,000. The mixture model has been employed as 

the multiphase flow model while K-ε  model has been used to account for the turbulence 

effects of the flow. Two different types of slurries have been considered for analysis. The 

first one is the flow of ADP particles in Xylene as the liquid and another is the Calcium 

Carbonate particles in water as the flowing liquid. 
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1.4 Aims and objectives to accomplish: The present study aims at the following tasks:  

- To apply CFD to visualize the flow over and through the sensing gap of the FTIR probe.  

- To determine the volume fraction profiles of the particles flowing through the sensing 

gap. 

- To determine the velocity profiles of the particles flowing through the sensing gap. 



 5

CHAPTER II 
 
 

REVIEW OF LITERATURE 

 

2.1 Introduction:        

This chapter deals with the studies and investigations done by researchers and 

scientists around the world in the field of Computational Fluid Dynamics (CFD). The 

discussion in the current study will be focusing on the multiphase flow consisting of solid 

particles and liquid fluids with turbulent characteristics. This chapter will also deal with a 

little discussion about the Fourier transformed infrared spectroscopic studies. In the 

current study the area to be given attention is the CFD simulations of turbulent slurry 

flows through pipe, hence major stress has been given on these keywords. Therefore this 

chapter includes the review of most relevant literature available. In the first part of the 

chapter, studies related to the CFD have been covered while the later part deals in brief 

about Fourier transformed spectroscopic studies and some of their applications.  

2.2 Numerical simulation studies in two phase flow:  As the present study deals with 

the flow of ADP particles with Xylene as the liquid fluid hence it is necessary that the 

particles should remain in suspension with the liquid while during the flow. Various 

studies have been conducted in order to determine the factors that are responsible to make 

the particles flow with the liquid fluid. This section will cover the previous studies and 
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researches made in order to discuss the effects of governing parameters on the flow 

characteristics and its behavior in a two phase flow. These parameters are particle size, 

particle concentration and particle velocities to name a few. Xu et al. (2004) have 

conducted numerical simulations in order to simulate the flow of solid hydrogen particles 

in liquid helium. They concluded that the flow must be turbulent else the hydrogen 

particles will form a sliding layer over the helium layer. The concentration profiles of 

hydrogen particles have been found to be dependent upon the size of particles, the 

velocity of flow and the inlet volume fraction of the hydrogen particles.  

Similarly Oey et al. (2001) have simulated the flow of gas-liquid and solid flow in 

an internal loop airlift reactor. They have made use of the two phase flow approach in 

order to simulate a three phase mixture of solid, liquid and gas by treating the airlift loop 

as two phase system i.e. a gas-liquid two phase system. They were able to detect different 

flow regimes by varying the gas flow rate. They also concluded that turbulent dispersion 

of the solid particles is needed in order to prevent them from settling down at the dead 

corners. The solid particle distribution is found to be smooth with higher volume fraction 

of solids in the lower part of the lower comers when the turbulent dispersion is taken into 

consideration. When turbulent dispersion is taken into account equilibrium between 

settling and dispersion is found. 

 Kasat et al. (2008) developed a CFD model in order to evaluate the complex 

interaction between the solid particles and the liquid phase mixing in a stirred slurry 

reactor. They studied the characteristic behavior of mixing time of the solid liquid 

suspension as a function of the impeller speed. According to them the mixing time 

increases with the increment in impeller speed and then reaches a maximum value and 
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further increment in impeller speed brings a gradual decrease in the mixing time. They 

have attributed the delayed mixing of the solid and liquid phases to the low velocities in 

the upper clear liquid region in the reactor. Their CFD model can be used for large scale 

industrial studies which involve the suspension and mixing of solid particles into liquids. 

 

2.3 Studies of two phase slurries in pipes: In this portion of the chapter, discussion is 

primarily focused on studies involving solid-liquid flow through pipelines.  

 Brown (1999) studied the abrasive nature of a slurry consisting of bauxite 

particles flowing with caustic liquid by predicting the erosion taking place in the 

pipelines. He developed a three dimensional CFD model bases on Eulerian- Eulerian 

continuum approach. He has used K-ε  model to account for the turbulence effects at the 

Tee section. A swirling inlet flow condition has been preferred to be used to accurately 

predict the accumulation of particles and the position of accumulation. They have 

employed a multiphase model with the help of which a solution for the erosion problem 

has been obtained. The problem of erosion has been found to be decreased by using a 

pivoted elbow design in place of a Tee junction. They have shown the ability of 

applications of CFD to the industrial problems which occur due to erosion phenomenon. 

It has been observed that deposition critical velocity plays an important role in the 

design of the pipelines made for the slurry flows. It is the magnitude of minimum flow 

velocity at which the flow of slurries can remain suspended in the pipeline. It has been 

found that the deposition velocity of flow depends on several factors including the size of 

the particles, the density of particles, the diameter of pipe and the solid concentration of 

the slurries. Kaushal et al. (2002) have conducted experiments to measure the 
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concentration at the pipe bottom at deposition velocity. They have utilized the data 

studied by Kaushal et al. (1995), Mukhtar et al. (1991), Seshadri et al. (1975) and 

Seshadri et al. (1980) with variable size iron ore particles, copper tailings and zinc 

tailings slurries flowing through pipes. The diameters of the pipelines which were 

considered are 55 mm and 105 mm.  They have made modifications to Karabela’s model 

(1977) on the basis of their studies. The original Karabela’s model determines the solid 

concentration profiles in a slurry consisting of multisized particles with help of an 

equation. The Karabela’s equation take into account the particle diffusivity, the particle 

size, and settling velocity. There are two assumptions involved in determining the solid 

concentration profiles in Karabela’s model. Firstly, the dimensionless eddy diffusivity is 

taken constant and is independent of space coordinates and solid concentration. Second, 

the solid concentration is assumed to depend only on vertical coordinate. It has been 

found that the overall concentration profiles predicted by the modified Karabelas model 

for 30 sets of experimental data holds good agreement for almost all of them. The 

original Karabelas model gives large deviations particularly for higher concentrations. 

Thus it has been concluded that the modified Karabelas model is more accurate. This is 

due to incorporating the solid concentration effects on settling of particles and the 

turbulent eddy diffusivity. Thus it has been proved that turbulence is affected by solid 

concentration. Further, the deposition velocity can be obtained using the ratio of 

concentration at the bottom and static settled concentration. Also deposition takes place 

when solid concentration at the bottom becomes equal to three times the product of efflux 

concentration and static settled concentration. 
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Deposition critical velocity plays an important role in the flow of slurries through 

pipelines. However designing a pipeline also requires lot of parameters which needs to be 

considered. Pressure drop through the pipeline is one of the important factors that should 

be given importance. In order to design a pipeline carrying slurries it is necessary to 

know the pressure drop. Also it helps to choose the power of the pumping device. 

Kaushal et al. (2005) made an attempt to measure the pressure drop and concentration 

profiles in horizontal, vertical and 45o inclined planes including the axis of the pipe. The 

diameter of the pipe was 54.9 mm. The concentration profiles were obtained by 

traversing isokinetic sampling probes. They have used two types of glass bead particles 

with mean diameters 440µ m and 125 µ m respectivelly. They have developed the 

experimental set up as shown in the figure 2.1.  

       

        Fig. 2.1 Test loop used by Kaushal et al. (2005) 

Pipe diameter is 54.9 mm while the rig has a 22 m long recirculating pipe loop with 

slurry tank having capacity of 200 L. It also consists of 150 L capacity water tank along 

with a centrifugal pump to maintain the flow of slurry. The supply of slurry is done 

through tank 7 (Fig. 2.1) where proper mixing of water and solid particles are done 
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mechanically using an electric mixer. It is ensured with the help of the mixer that 

distribution of particles should be homogenous. The outlet of the tank is situated at 10 cm 

above the bottom i.e. almost 10 cm below the impeller. There is an additional water tank 

10 (as shown in Fig. 2.1) connected in parallel with the slurry tank which has been 

employed to reduce the variation of mixture level in the tank at start up and shut down. 

The circulation of slurry in the loop is done with a centrifugal pump with the operating 

conditions of – 15 kW with a rate of 0.6 cubic meters per min at 22 m head. Slurry 

volumetric flow rate is measured with the help of an electromagnetic flow meter 2 (as 

shown in Fig. 2.1). A sampling probe 3 (as shown in Fig. 2.1) is used to measure the 

concentration profiles. It has a rectangular slot of area 5 mm x 6 mm which is 3 mm 

above the end. Samples were collected in horizontal, vertical and 45o inclined planes at 

different locations ensuring the slurry flow is uniform and uninterrupted. On the basis of 

their results they have concluded that variation in flow velocity does not bring any 

significant variation in the concentration in horizontal plane. They have obtained a 

unique change of concentration profile for 440 µ m particles which indicated a sliding 

bed regime. They also found that high frictional losses are associated with narrow 

grading particles (small diameter) and broad grading particles (larger diameter) have low 

frictional losses at higher concentrations. 

 In another study, Kaushal et al. (2002) have modified the model for solids 

concentration profiles and composites proposed by Kaushal and Tomita (2002). They 

have included the effect of particle size and efflux concentration of particle diffusivity. 

They have calculated the ratio of homogeneously distributed concentration and 

heterogeneously distributed concentration for each size of particles present in the slurry. 
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They have calculated the total pressure drop in the pipe by adding the pressure drop 

through the homogenously distributed and heterogeneously distributed portions of all the 

particle sizes. They have also done the experiments to calculate the pressure drop to 

validate the results. These pressure drop results obtained are found to be more accurate 

than those obtained by previous researchers and were found to be in good agreement with 

the experimental results. They calculated the mean square difference values between 

predicted and experimental values and have expressed as percentage of the measured 

value.  Their comparison statistics have shown the variation for different models as Wasp 

et al. (1977) with 5-21.8%, Gillies model (1991) with 6-9.2 %, Kaushal and Tomita 

model (2002) with 1.7-3.5 % and the proposed model with just 1.6-2.0 %. 

 Kumar et al (2003) have also conducted studies with varied range of efflux 

concentration and particle size through slurry pipelines carrying liquid solid flows. They 

have measured the pressure drop and distribution of solid concentration. They have 

measured the particle size effects on pressure drop utilizing the solid distribution in the 

pipe. They have employed an integral flow model to determine the optimum particle size 

for which the specific energy consumption is minimum. They have used the integral flow 

model for predicting pressure drop and solid particle concentration. They have proved 

that there can be an optimum size of particles for which the energy required for 

transportation of slurry having that particle size will be lesser than the energy required for 

slurry having even smaller particle size. They have also concluded that modified 

Karabela’s model is able to predict the solid concentration with good accuracy. 

 Ling et al. (2001) have used a horizontal pipeline having a fully developed solid 

liquid flow in order to perform the numerical investigations. They have employed an 
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algebraic slip model (ASM) in order to model two phase flow and RNG K- ε  model for 

accurately modeling the turbulence effects. They have used an unstructured grid in order 

to discretize the flow domain. Finite volume method is used for the determining the 

solution of the governing equations. The pipeline used in the study has a length of 1.4 m 

with a diameter of 0.0221 m. They have used silica sand and Zirconia sand particles with 

densities of 2380 Kg per cubic meter and 4223 Kg per cubic meter respectively. They 

have displayed various slurry characteristics which include slurry density, volume 

fraction variations, slip velocity magnitude, slurry mean velocity variations and skin 

friction variation. Their results vary significantly for silica and zirconia sand particles as 

they have different densities. Their results have been found in good agreement with the 

experimental data when the slurry mean velocity has a magnitude higher than the critical 

deposition velocity. Their results are also found to match the results obtained in current 

research which are presented in Results and Discussion section. The effects of density of 

particles are clearly visible in the results obtained. 

 Lin et al (2007) have studied the developing slurry flow in the entrance region of 

a horizontal pipe. They have also used algebraic slip model (ASM) in order to model two 

phase flow and RNG K-ε  model for modeling the turbulence effects. They have used an 

unstructured grid with 67200 cells. The turbulence intensity level used in their 

computations as a boundary condition is 4%. They have plotted the profiles for 

comparison of volume fraction, density distribution, mean velocity profiles and mean 

skin friction coefficients. They have also shown the variation of volume fraction in the 

vertical central plane of the pipe’s cross section for volume fractions 0.172414 and 

0.20689. This is shown in Fig. 2.2. The results obtained in the current research for 
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velocity profiles along the vertical axis in the entrance region of the pipe slurry flow are 

compared with those obtained by Lin et al in chapter 4. The results of Lin et al. for 

velocity profiles of slurry are shown in Fig. 2.3. They have concluded that volume 

fraction and mean density will be lower in the upper part compared to lower part of the 

pipe in the entrance region. In the fully developed region, in the upper part of pipe, the 

solid liquid density will be almost equal to primary fluid density and the volume fraction 

will be almost zero. 

                         

 Fig. 2.2 Evolution of volume fraction of silica sand at the vertical central plane of 
the pipe’s cross section (Source: Lin et al (2007)) 
 
 Hossain et al (2003) have used the multiphase mixture model available in Fluent 

in order to study the particle deposition and suspension in a horizontal pipe flow. They 

have considered the diameter of particle, density of fluid and velocity of fluid as the 

decisive factors for the deposition of particles in the pipe flow. Similar to the current 

research, they have also considered the gravitational forces as well as hydrodynamic drag 

forces on the particles. They have quantified the gravitational settling velocities and free 

flight velocities. It has been concluded on the basis of same that those larger particles that 

have gravitational settling velocity more than twice their free flight velocities will be 

more likely to settle. Similarly, smaller particles with gravitational settling velocities less 

than half of their free flight velocities will be have dominance of turbulent diffusion and 
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hence are dispersed along the cross section of the pipe. The results obtained in the current 

research are compared with findings expressed by Hossain et al. in chapter 4.               

                        
 Fig. 2.3 Velocity profiles of single and double species slurry flow along the vertical 
 centerline from the entrance region to fully developed slurry flow region (volume 
 fraction=20%, particle diameter =100 microns, pipe diameter = 0.0221m (Source: 
 Lin et al (2007)) 
  

Eesa et al. (2008) have conducted similar studies and have used a Eulerian-

Eulerian Computational fluid dynamics approach for investigating the flow of coarse 

particles in a horizontal or vertical pipe. They also conducted experimental measurements 

in order to validate the results predicted through modeling. The positron emission particle 

technique (PEPT) has been utilized for the experimental verification. The results of the 

previous studies have been used in the validation of the pressure drop computations. The 

particles employed in the study can be considered neutrally buoyant. The solid and liquid 

phase velocities, pressure drop and particle concentration profiles are found to be 
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dependent upon the particle diameter and their concentration, mean flow velocity and the 

rheological properties that the carrier fluid possesses. Due to large particle diameters, 

asymmetry is found to arise in the solid as well as liquid velocity profiles. Pseudo- 

homogeneous flow takes place for smaller particles while the concentration profiles are 

distorted for particles with larger diameters as larger particles are more likely to settle 

during the flow. Higher solid concentrations result in increase in pressure drop along with 

more uniform radial distribution of particles. The non-dimensional solid and liquid phase 

velocities and particle concentration profiles were not dependent on the particle diameter 

and their concentrations. 

 Kaushal et al. (2002) have studied the concentration profiles along with the 

pressure drop through a pipe of diameter 105 mm for a zinc tailings slurry flow 

consisting of more than one size particle. The particle size in the slurry ranges from 38 

µ m to 739 µ m. It has been observed that many researchers have made attempts in the 

direction of prediction of pressure drop along with Wasp et al. (1977),  Doron et al., 

(1987),  Gillies et al. (1991), Sundqvist et al (1996),  Mishra et al. (1998),  Ghanta and 

Purohit, (1999),  Wilson et al. (2002),  to name some of them.  Out of these, the 

approaches and models proposed by Wasp et al. (1977) and Gillies et al. (1991) are more 

accurate. Kaushal et al. (2002) have made an attempt to modify Wasp et al.’s two layer 

model. They have also modified the Karabelas (1977) empirical model for solid 

concentration profiles. They have conducted the experiments with three different flow 

velocity magnitudes of 2m/s, 2.75m/s and 3.5m/s. The efflux concentration for each 

velocity magnitude ranges from 4% to 26 % by volume. Like other researchers, they also 

observed that the solid concentration profiles were functions of particle size, flow 
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velocity and particle efflux concentration of slurry. In case of pressure drop 

measurements flow velocities ranged between 1.2m/s to 4m/s. with the efflux 

concentration ranging between 4% to 26% by volume.  

 Kaushal et al. (2002) have compared the results obtained for solid particles 

concentration profiles with those predicted by the Karebelas (1977) model. It has been 

observed that the model predicts accurately for the finest particle size but as the particle 

size increase the results predicted vary such that it overestimates the concentration at the 

bottom of pipe while underestimating the same at the top of the pipe. On the other hand, 

comparison of the experimental data for pressure drop with those predicted by the Wasp 

model shows good agreement when the efflux concentration is low at all values of flow 

velocities. Exceptions are found when the efflux concentration was high along with high 

flow velocities. The predictions made by Gillies et al’ s (1991) two layer model were 

found to be in good agreement with the experimental results. Kaushal et al. (2002) have 

made changes by modifying some of the limiting assumptions used in the Karebelas and 

Wasp models. It has been observed that the modified Karebelas and Wasp models are 

capable enough to predict accurate results which established fair consensus with 

experiments.  

2.4 Other studies focusing on two phase: This portion will discuss some other studies 

in which flow is taking place through any other geometry except the pipe.  

 Wei et al. (2002) have developed a K-ε -T model in order to predict the flow 

characteristics of dense liquid –solid flows. They have used fluid turbulent kinetic energy 

and turbulent dissipation rate to describe the turbulent flow of fluid. On the other hand 

they used turbulent kinetic energy, dissipation rate and pseudo thermal temperature to 
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describe the random motion of particles. They have explained that random velocity 

associated with collection of particles is characterized by the turbulent kinetic energy of 

the particles. In case of an individual particle the random velocity magnitude is defined 

by the pseudo thermal temperature. They have designed the iterative procedure required 

to solve the equations involved in the modeling. Their simulation results were found to be 

in good agreement with the literature. They have concluded that anisotropy dominates in 

two phase flows.  

As discussed in the above paragraphs, Xu et al’s (2004) research is inspired from 

the working of atomic hydrogen propellant feed systems in which the solid hydrogen 

particles may be transported to engines by using the carrier fluid in the form of liquid 

helium. They have made use of three dimensional two phase mixture model in order to 

simulate the flow of the solid hydrogen particles and liquid helium. They utilized the K-

ε  mixture turbulence model which plays a crucial role in the turbulent mixing of the 

solid particles and liquid fluid. They indicated that the slurry flow of hydrogen-helium 

has a high Reynolds number. The Stokes number which is defined as the ratio of the 

particle response time to the fluid response time also plays an important role. When its 

value is less than one the particle motion will be tightly coupled with fluid motion. It has 

been observed that the Stokes number for this two phase flow system is less than or equal 

to one which is mandatory in order for the hydrogen particles to attain the near 

equilibrium velocities so that the particles can remain in suspension with the liquid. 

Different test cases have been discussed on the basis of the governing factors and their 

influences on the dispersion of hydrogen particles in liquid helium. The governing factors 
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include the hydrogen particle size, inlet velocities and the inlet particle volume fraction. 

Table 2.2 shows the cases as identified by Xu et al. (2004), 

Test Case # Inlet velocity 

(m/s) 

Inlet particle volume 

fraction (%) 

Particle diameter (mm) 

1 1.0 19.0 1.00 

2 1.0 19.0 0.10 

3 1.0 19.0 0.01 

4 3.0 19.0 0.01 

5 3.0 30.0 0.01 

6 3.0 10.0 0.01 

7 5.0 19.0 0.01 

 

    Table 2.1 Cases as identified by Xu et al. (2004) 

 

Effect of particle size: Considering the case 1, 2 and 3 in the above table, contours of 

particle volume fraction have been obtained as shown in Fig.  2.4 for case 3, which have 

the smallest particle diameter of 0.01 mm, show the best results of all the three cases for 

the dispersion of hydrogen particles with a very small amount of particles accumulating 

at the top which is less than the cases 1 and 2.   
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 Fig. 2.4.Contour of particle volume fraction in the channels for different particle 
 sizes at elapsed time t=2 s. (Influx particle volume fraction αp,0=19.0%, flow 
 velocity ) (Source : Xu et al. (2004)) 
 

Also, they have plotted the normalized particle volume fraction curves along a channel 

parallel to the axis at the intersection of y=0.01m and z=0 planes in Fig. 2.5 It has been 

realized that the closer the normalized particle volume fraction is to 1 that much better 

will be the dispersion of hydrogen particles. Fig. 2.5 also supports the fact that small 

particle size is a better choice for better degree of particle dispersion. 

                                

 Fig. 2.5 Particle volume fraction at intersection of surfaces y=0.01 m and z=0 m for 
 different particle sizes at elapsed time t=2 s. (Influx particle volume fraction 
 αp,0=19.0%, flow velocity  m/s.) (Source: Xu et al. (2004)) 
 

Effect of Inlet velocities: In Table 2.1, consider the cases 3, 4 and 7 where all the 

parameters are constant except the influx velocities. The case 7 with inlet velocity as 
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5m/s. which is the highest of the three cases is found to have better dispersion. Thus, 

higher the inlet velocity better the particle dispersion achieved. 

Effect of inlet particle volume fraction: Here case 4, 5 and 6 from Table 2.1 with 

respectively 19%, 30% and 10% volume fraction have been discussed. It has been found 

that higher the influx volume fraction the better the particle distribution in the flow. 

Logos et al. (1995) have made an attempt to study the coal water slurries in terms 

of their rheological behavior. The rheological properties were established to be the 

functions of solid coal particle size, concentration, and the particle size distribution. 

These slurries have been formed by mixing water with coal particles with size of the 

order of 45µ m. For lower concentration of coal particles, slurries exhibit Newtonian 

fluid properties while for higher concentration they have viscoplastic and shear thinning 

effects. Their methods involved the mixing of coarser coal particles in the already 

existing fine coal particles slurry. In the first step they have used the size of coarser coal 

particles of the order of 208-279 µ m for mixing with the fine coal slurry keeping the 

solid particle concentration constant. This has resulted in a decrease in the slurry 

viscosity. Furthermore with a ratio of 40% -60% of coarse to fine coal particles in the 

slurry , slurry viscosity becomes almost five times smaller than that of the slurry with just 

fine particles with the same solid concentration. Another loss of slurry viscosity by 50% 

has been observed on adding the coarse coal particles with size ranging between 279-325 

µ m. They have explained this behavior owing to the effect of spatial rearrangement of 

the solid particles and an apparent dilution effect. Their results have proved that a coal-

water slurry can be formed with a high solid concentration but with a lower slurry 

viscosity. 
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 Fan et al. (2005) have used an improved inner outer iterative method in order to 

simulate the two phase solid liquid turbulent flows making use of slender particles 

instead of the regular spherical one. The inner outer approach mentioned here has been 

proposed by Brucato et al. (1998) and was later modified by Wang et al. (2002). The 

improved inner outer approach has been explained later in the discussion of Wang et al. 

(2002). The set up used in their modeling process consists of a tank which has the stirrer 

in the form of a Rushton turbine. They have employed the standard K-ε  turbulence 

model. Since the slender particles differ with the spherical particles in the fact that they 

are dependent on the orientation hence a comparison has been made between the results 

obtained using the slender particles with those obtained using spherical particles.  They 

have also conducted solid liquid two phase flow experiments in the baffled tank using the 

digital particle image velocimetry technique. This has been a useful step in order to 

validate the results obtained from simulation. They have compared the velocity profiles 

in the experimental and the simulation results following the cylindrical coordinate 

system. Fig.  2.6 shows the velocity profile of the two results.  

                                                                                          

Fig. 2.6 (a) Experimental velocity profile (b) Simulation velocity profile. Both are in 
r-z   plane. (Source: Fan et al. (2005)) 
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They have studied the orientation of slender particles and the effect of impeller speed on 

the orientation. They used three different speeds i.e. at 200, 300 and 400 rpm of the 

impeller. It has been observed that the radial and axial velocities as well as the fluctuation 

velocities are increased due to increase in impeller speed while there is a decrease in the 

solid concentration in the center of the tank owing to the fact that high impeller speeds 

result in better and uniform dispersion of particles in the tank. As there is increase in the 

impeller speed the orientation of the slender particles in the far region from the impeller 

is not affected. In the near region the orientation decreases with increase in impeller 

speed due to the particles following the direction of the impeller with large speed.  

Comparison has been made on the basis of three different velocity components of the 

flow in case of slender particles and spherical particles of equal volume. Fig. 2.7 shows 

the comparison curve obtained. 

                      

 Fig. 2.7 Comparison of simulated velocity between spherical and slender  
 particles. (Source: Fan et al. (2005)) 

 

It can be inferred that the velocity components for two types of particles are 

similar. This can be explained using the fact that due to the high impeller speed, 

turbulence effects dominate over the particle shape characteristics. 
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 Wang et al. (2003) have also studied the dispersion of solid particles in a solid-

liquid baffled stirred vessel with a Rushton impeller. They have also utilized the 

improved inner outer iterative procedure. They have made an attempt to determine the 

recirculation below the impeller. They have also used K-ε  turbulence model for 

simulations. According to Wang et al. the main problems encountered in simulation of 

flow field in stirred vessels involving multiphase flow are the exact representation of the 

impeller action, the interactions between the participating phases and the turbulent 

quantities. They have intended to extend this work as a base for the design and 

modification of solid liquid mixing vessels by numerical simulation. The modified inner 

outer approach as mentioned earlier subdivides the whole computational domain into two 

zones which are partially overlapping. Fig. 2.8 shows the two zones of the modified inner 

outer iterative method.                   

      

 Fig. 2.8.Inner and outer zones in modified inner outer iterative method.  
 (Source: Wang et al. (2003)) 
 

The inner zone has the impeller while the outer zone consists of the wall baffles. In the 

computational process, first the inner domain is simulated in the reference frame that 
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rotates with the impeller using the arbitrary boundary conditions that are imposed on 

surface ∑ 2. This will result in the first trial flow field to be obtained in the impeller 

region inclusive of the flow parameters distribution on surface ∑ 1. The flow parameters 

distribution obtained on the surface ∑ 1 is used in the form of the boundary conditions to 

simulate the flow on the outer domain. The flow parameters have not been averaged and 

hence the information available represents the whole of the computational domain which 

fortunately also includes flow parameters on the boundary surface ∑ 2. Further the 

parameters on the surface ∑ 2 are used for the second inner simulation as the boundary 

condition. This will continue until a satisfactory numerical solution is obtained by 

convergence. Fig. 2.9 shows the computational grid used. It has 36 x 36 x 90 nodes in all. 

Wang et al. have compared their grid with those used in the previous similar studies by 

Gosman et al. (1992) with 20 x 15 x 27 nodes and Altway et al. (2001) with 21 x 64 x 45 

nodes. They have used a better and denser grid comparatively.  

                            

   Fig.  2.9 Computational grid of ‘inner’ and ‘outer’ domains. (Source: Wang et 
 al. (2003)) 
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 The study conducted by Wang et al. (2003) can be used for the systems of solid-liquid 

flows where the solid loading can be as high as 20%. They have modified the inner-outer 

approach which can be applied to other systems also where there is an unavailability of 

the experimental data for the initial boundary conditions. 

   

2.5 Fourier Transformed Infrared (FTIR) spectroscopy: Fourier transform 

spectroscopy can be defined as a technique used for measurement in which the time 

dependent coherence of a radiative source is measured in order to collect the spectra. 

These spectra are required for the study of the material or mixture characteristics. 

Infrared spectroscopy is the spectroscopy technique that deals with the infrared region of 

the electromagnetic spectrum. The Fourier transform spectroscopy when combined with 

infrared spectroscopy brings the Fourier Transformed Infrared (FTIR) spectroscopy into 

existence. An FTIR method consists of collecting an interferogram with the help of 

interferometer and then it is Fourier transformed to get the spectra. The FTIR 

spectrometer is used to digitize the interferogram and does the Fourier transformation to 

yield the spectrum. Either near infrared or far infrared spectra can be obtained by a FTIR 

spectrometer.  The FTIR spectrometer offers advantages of high spectral resolution, the 

capability of working with weak signals, high spectral accuracy, quick acquisition of 

spectra with high signal to noise ratio (S/N ratio) and the capability to work with infrared. 

FTIR spectroscopy has a wide range of applications. In the current study, FTIR/NIR 

probes are considered for applications to a turbulent slurry flow. In this section an 

attempt has been made to review some of the applications of FTIR/NIR methods. 
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2.5.1 Studies related to FTIR/NIR spectroscopy: 

Abebe et al. (2007) have conducted experiments that indicate that Near Infrared 

spectroscopy is a very good tool while dealing with slurries. According to them the 

manufacturing processes that involve solid particulates pose a higher degree of 

difficulties in various chemical, nuclear and pharmaceutical industries as compared to 

single phase liquids and gases. Lack of effective measurement techniques contributes a 

lot to the difficulties resulting in optimization and precision manufacturing of particulate 

solid products. Their experiments demonstrate that NIR spectra can reveal rich and 

important information about the concentration of solution, solid concentration, particle 

size and the crystal structure. They have stated that NIR technique has a wide potential 

for simultaneous measurements of multiple number of solids as well as liquid properties. 

They have carried out their experiments using a 500 ml jacketed glass reactor. They have 

used distilled water as the liquid while the chemicals they have employed are L-glutamic 

acid (L-GA). They have used two different forms of L-glutamic acid namely α and β  

forms. The experimental set up is shown in Fig.  2.10. The glass reactor consist of a 

retreat curve impeller, a temperature control bath, a Platinum resistance thermometer (PT 

100), a glass condenser and the NIR transflectance probe having 12 mm optical path 

length. A 2m silica fiber optics cable is used to transmit signal to the FT-NIR 

spectrometer. 
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Fig. 2.10.Experimental set up. 1 Personal computer, 2 NIR instrument, 3 Fiber 
optics cable, 4 Transflectance probe, 5 Stirrer motor, 6, Temperature probe, 7 
Reactor temperature control, 8 Stirrer, 9 glass jacketed reactor (500 ml), 10 
Condenser.  
 

The slurries were made for both α and β crystals and at different solid concentrations, and 

over the six particle size ranges for each polymorph. The effect of crystal size on 

absorbance was explained using the raw spectra plots of the slurries as shown in Fig. 

2.11. On the other hand, they have explained the effect of solid concentration using Fig.  

2.12. It has been observed that higher the solid concentration the larger will be the 

baseline shift. The greater solid concentration results in more scattering of radiation and 

hence less light reaching the detector ultimately resulting in baseline shift at all 

wavelengths. They have concluded that near infrared radiations are very much effective 

in predicting the slurry characteristics like particle size, and concentration unlike mid 

infrareds. NIR spectroscopy can be used as an effective technique in chemical, 

agricultural and environmental applications owing to the properties such as ability to use 

fiber-optics for rapid data transmission, good accuracy in measuring both low and high 

concentrations of solutions, and simple in operation. 



 28

                

Fig. 2.11. Raw NIR spectra of slurries of α-form L-GA crystals of different particle 
sizes, under fixed temperature and solid concentration. 
 

       

Fig. 2.12. α-form spectra at varied solid concentrations but fixed particle size 
(70 µm) and temperature (40 °C) 

 

It has been observed that the indoor concentrations of substances like 

formaldehyde (HCHO) and nitrogen dioxide (NO2) have increased compared to that 

outside and these concentrations obviously are capable of producing adverse results. The 

quantitative measurement for such substances is a must to ensure better quality of 

ambience though it is not possible to do this accurately with conventional methods. In 



 29

such a circumstance FTIR spectroscopy techniques prove to be advantageous. Chen et al. 

(1999) have studied the quality of the indoor air in a simulated kitchen ambience. They 

have measured concentrations of major combustion products like carbon dioxide, carbon 

monoxide and nitric oxide in a room where a conventional natural gas appliance is 

operated. They have employed FTIR extractive technique in order to measure the 

combustion products. A comparison has been made further with the results obtained by 

FTIR technique and those which were obtained from conventional techniques. The FTIR 

technique was proven to be better. On the other hand they have also furnished the CFD 

simulations which helped in designing the experimental set up along with interpreting the 

experimental data. The experimental set up is shown below in Fig.  2.13. It has a room 

with a conventional four burner stove gas cook top system. The cook top produces a blue 

flame during the experiments. Air has been taken out using an exhaust fan while fresh air 

is made to enter using a meshed vent. Three different experiment cases were considered 

on the basis of different ventilation rates of 2.4, 4.3 and 6.6 air changes per hour (ACH). 

The total heat generating rate was 3.92kW meter per hour. Similarly while in the CFD 

simulations three different cases were considered. The grid used for modeling has same 

                                         

Fig. 2.13.Experimental set up with the measurement locations and cook ups at S1, 
S2, S3 and S4. (Source: Chen et al. (1999)) 
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dimensions as that of the testing room. It has 29 x 32 x 34 cells in the direction 

coordinates. The combustion source is modeled on the box shaped obstacle. CFX4 has 

been used as the CFD package which uses the finite volume methods for solving the 

conservation equations that govern the problem. A K-ε  model with buoyancy correction 

has been utilized. The simulation results can be depicted as shown in the Fig.  2.14. The 

results obtained using CFD simulations were able to predict similar qualitative results as 

obtained by the experiments. The confirmation of stratification of temperature and 

combustion products concentration has been made. High flow rates were better predicted 

quantitatively than lower flow rates. This may be due to the use of a less sophisticated 

turbulence model. Hence, Reynolds flux model can be used. It has been proved that a 

high flow rate system needs to be positioned above the source to extract the major part of 

pollutants. 

 

Fig. 2.14. Predicted velocity vectors and CO2 mass fraction contours at the 
centre y plane for an air flow rate of 2.4 ACH. (Source: Chen et al. (1999)) 
 

FTIR spectroscopy can be combined with other techniques to obtain desired 

solutions. Fabbri et al. (2000) have combined the mid infrared fiber optics (wavelength 
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ranging between 1100 nm to 2500 nm) technique with FTIR in order to devise a method 

with the help of which a non-invasive reflectance measurements can be performed. It has 

a wider area of application in the field of non-invasive analysis of aesthetic works. With 

this technique measurements can be done with paintings and polychrome sculptures with 

the view to analyze the composition of painted layers without sampling. This technique 

uses portable FTIR spectrophotometer using mid infrared fiber optics which enables it to 

be used on site, i.e., without even moving objects from their places. They have introduced 

two terms: Surface reflection (Rs) and volume reflection (Rv). Surface reflections are the 

radiations that have not entered the sample and have suffered single or multiple 

reflections on the upper surface of the particles of the sample while volume reflections 

are those radiations that enter the sample and are reflected back after suffering internal 

partial refractions getting transmitted by the particles.  

Friesen (1996) have used an online fiber optic probe in order to collect the spectra 

of a slurry flowing through a pipe. An attempt has been made to verify the feasibility of 

the NIR spectroscopy method for developing a reliable method for processing of oil sand 

slurries in oil sand extraction plants. They have gathered data for a continuous period of 

nine hours for which there has been a regular variation of the type of ore and the slurry 

water content. They have utilized a near infrared reflectance analysis (NIRA) technique. 

They have used an NIR spectrometer installed at a point downstream from the tumbler 

which is used to mix hot water and sodium hydroxide with oil sand in the first step of hot 

water extraction. The spectrometer with a protective cover has been mounted on a 

vibration isolation platform placed on steel table close to the measurement point. A probe 

with 1m long fiber optic bundle has been inserted into the pipeline having the probe 
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diameter of 25mm such the window was flush with inside surface of the pipe. The 

window material is made of sapphire due to high resistance required against abrasion due 

to sand.  This method is used as an efficient method for characterizing the appropriate 

samples owing to its advantages of being prompt and non destructive technique. 

Following this method,  if there is any need for sample preparation in a specific case, it 

requires very small amount of sample preparation. This method can be used to analyze 

large samples. 

Switalski et al. (1998) have also tried to investigate the near infrared (NIR) 

diffuse reflectance spectroscopy as a processing method. Diffuse reflectance carries the 

merit of analyzing powders having as high as 40% volatility, slurries consisting of as 

much as 40% solid concentration and emulsions as well. Diffuse reflectance spectroscopy 

has the capability to examine both the solid and liquid phases on the substance. In this 

study efforts have been made by researchers to monitor the dryer simulator that is used 

for the simulation of production rotary dryer in the laboratory. They have mentioned the 

examples from the industry using NIR diffuse reflectance spectroscopy in monitoring the 

chemical industry processes of mixing, drying and polymorphism. These are indicative of 

the fact that many of the other processes can be monitored using this technique. 

3 Conclusions: 

 Thus, from the above discussion some of the points that are eligible to attract our 

attention include the dependence of multiphase solid-liquid flows on the solid particle 

inlet concentrations, inlet velocities of the solid and liquid phases and the particle shape 

and size. It has been observed that smaller the particle diameter better will be the particle 

dispersion. Spherical particle shapes are likely to disperse more than the slender ones. 
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Higher inlet velocity and high inlet volume fraction contributes to better dispersion of 

solid particles. It was also observed that in order for the flow of solid particles with the 

liquid fluids the velocity of the solid particles should be just above the deposition critical 

velocity. In order to achieve such a velocity or more precisely to maintain the particles in 

suspension in the flow the phenomenon of turbulence is a must. Turbulent mixing plays a 

vital role for the particle dispersion. In order to simulate the turbulent flows K-ε  

turbulence model is most preferred. Turbulent K-ε  model has been found to be the 

widely used turbulence model. It can be used efficiently in both dilute as well as dense 

solid liquid flows.  

FTIR methods have also been used as efficient technique for non-invasive 

measurements as well as in the analysis of liquid slurry characteristics. Being a non-

destructive technique, it requires little or no sample preparation. An optical probe can be 

employed which can be used for the detection of the substances. Thus in the present study 

all these considerations have been taken in to account in order to optimize the quality of 

obtained results. 
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CHAPTER III 
 
 

NUMERICAL APPROACH   

 

3.1 Introduction 

  Computational Fluid Dynamics (CFD) is classified as a branch of fluid mechanics 

which deals with the numerical solution of flow of fluids by employing the computational 

power of modern computers. Computational Fluid Dynamics solves the governing 

differential equations that are characteristic to the flow. These governing equations 

consist of the equations of continuity, conservation of momentum also known as Navier 

Stokes equations and equation of conservation of energy. On the other hand, in case of 

inviscid flow the Euler equations are momentum equations which govern the flow. In the 

present study we are dealing with the viscous flow. So the prime concern will be the 

solution of Continuity and Navier Stokes equation.  Some of the advantages of using 

CFD methods are considered to be the accuracy and reliability of the end results, lower 

cost of application of CFD compared to the expensive experimental methods, availability 

of software and graphical tools to visualize the flow without actually making the fluid to 

flow which results in accurate predictions. In addition, the study of dangerous species can 

be performed without any risk.
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  In CFD, a continuous fluid is discretized by considering the flow domain to be 

constituted of very small units called cells. This cell structure in the flow volume is 

known as mesh or grid. These cells are used for the analysis of the flow problem. When 

proceeding with the cell-based analysis approach, a preprocessing is required. For 

preprocessing, the geometry of the problem should be understood. Mesh has to be 

constructed in the region where the fluid is going to flow. Further, one should be aware of 

the governing equations on which the flow properties are dependent. These governing 

equations may also include some equations which are specific to the problem or type of 

fluid. Furthermore, the boundary conditions of the flow problem play a major role in 

determining the accuracy of the simulation process and have to be given attention during 

the preprocessing of the flow problem. Boundary conditions specify the fluid 

characteristics at the flow boundaries and the specific properties of viscosity, surface 

tension that the fluid has.  

  Computational Fluid Dynamics can be used to model flow with low Reynolds 

number as well as those with high Reynolds number. Various turbulent modeling and 

simulation techniques like Direct Numerical Simulation (DNS), Large Eddy Simulation 

(LES), Reynolds stress model, K-Epsilon model, K-Omega model, Spalart-Allmaras 

model are available and each one of them can be efficiently used in their specific areas of 

applications. These will be covered in some detail later in this chapter. In the present 

study wall bounded turbulent flows have been modeled and the K-Epsilon model with 

near wall treatment has been employed. 

CFD techniques are suitable for the areas of single phase flow as well as 

multiphase flow. A multiphase phase flow will have the flow consisting of gas-solid, 
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solid-liquid, gas-liquid phases, liquid-liquid phases or even more than two phases. The 

point to be considered is that the phases must be non-reacting during the flow. The 

complexity in the flow arises due to the mutual interaction of different phases. 

Experimental methods are not capable in every case to completely analyze the flow. 

Currently, our area of consideration is the flow of solid (particles) and liquid phases 

where even the clustering of suspended particles depends upon the small scales of 

turbulence to be resolved. This is very difficult using experimental techniques. Hence 

numerical simulation plays an important role for the analysis of multiphase turbulent flow 

problems. Using the computational techniques the role of some crucial physical factors 

including the effect of gravity and surface tension can be also evaluated in the flow 

problems.  

As it has been mentioned earlier that CFD requires computational power of 

modern computers in order to give useful results, hence it requires software application 

codes in order to do the computational work. Many CFD software applications are 

available that can be used on the basis of the advantages they offer in different fields of 

applications. In the current research, Fluent has been used as the simulation software 

package and Gambit has been utilized as the preprocessor. As we mentioned that meshing 

of flow geometry needs to be done before simulating the flow, Gambit is used for the 

construction and meshing of the flow geometry. In this case, flow geometry is a pipe with 

a Fourier Transformed Infrared Reflectance (FTIR) probe placed at half of the length of 

the pipe inserted through the upper wall of the pipe. The construction and meshing of the 

probe and pipe geometry are considered later in this chapter. 
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3.2 Governing Equations                                                                                                    

The governing equations are nothing but the mathematical representations of 

the principles that controls the flow behavior in a particular fluid problem. These 

principles are the conservation of mass, momentum, and energy. For the present study, 

one has to deal with the equations of continuity which represents the conservation of 

mass principle and Navier Stokes equations in three different coordinate axes which 

respectively represent the momentum conservation principles in the directions of X, Y 

and Z. Following are the equations as discussed in the preceding lines. The equation of 

continuity or conservation of mass in three dimensional coordinate systems is expressed.  

 

                                                                       (3.1) 

 

Where u, v, w are the velocity components in X, Y and Z directions. This is 

the continuity equation for incompressible flow. The Navier stokes equation is expressed. 

 

                                 (3.2) 

 

 

This is the basic form of Navier Stokes equations where each term has its 

own meaning which is explained as 
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    (3.3) 

 

Thus, the terms on the left represents the acceleration of the fluid while the 

terms on the right hand side stand for the forces acting on the fluid. The above equation 

holds good when talking about incompressible constant viscosity flow. The Navier 

Stokes equation is a form of conservation of momentum which is explained from 

Newton’s second law of motion and the equation 

F = ma                                                                                                       (3.4) 

is justified as the Navier Stokes equation has acceleration terms on one side 

and all the existing forces on the other side. The Navier Stokes equation in the Cartesian 

form for three different coordinate axes for incompressible and constant viscosity flow 

yields,  

      

                 (3.5) 

    

                (3.6) 

 

             (3.7) 
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3.3 Numerical methods in CFD 

In the old days when CFD was discovered, experimental techniques were 

considered to be advantageous. Nowadays, due to the promptness and accuracy of the 

computational power, CFD is widely used. The solution of flow problems are obtained by 

discretizing and then solving the differential equations governing the flow. There is 

availability of several types of numerical methods for the solution of governing equations 

such as finite difference, finite volume, and finite element methods. For our area of 

concern all these three are of interest. 

 

Finite difference method: This method uses the Taylor series approximation at any 

general point xi. Thus any term of the PDE can be expressed as, 
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Where ∆ x represents the mesh size in the grid under consideration and is 

taken constant. fk represents the value of the function f(x) at xk. Taylor’s expansion gives 

the value of coefficients CJ. J1 and J2 are the integers which are related with the order n 

and the desired degree of accuracy. Thus following the above scheme the first and second 

order derivatives can be represented as follows. 
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(Here n=2 and J1 =1 and J2 =1 i.e. second order derivative with first order 

accurate scheme). 

For higher order derivatives the value of n will increase and for higher 

degree of accuracy the difference between J1 and J2 goes on increasing. Similar equations 

are used while discretizing the time derivatives having the time interval ∆ t. In finite 

difference method systems of governing differential equations is converted to a system of 

algebraic equations in terms of the value of function f at different nodes of the mesh. 

 

Finite element method: In this method the flow domain is discretized by dividing it into 

smaller divisions or elements and each element is considered while developing the 

solution using the basis functions. Thus the solution is obtained element wise in terms of 

the basis functions. As the solution is constructed in terms of the specific basis functions, 

it explains better about the solution as compared to the finite difference and finite volume 

methods. But there are always complications in choosing the basis functions which also 

brings ambiguity in determining the boundary conditions. This method is widely used for 

structural mechanics problems. It is also applied in areas of fluid studies. One more area 

of concern is that it requires more memory for computation comparatively. In this method 

a weighted residual equation is obtained which is represented as 

 

                                                                                 (3.11) 
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Where Ri is the equation residual at an element vertex i, Q represents 

conservation equation expressed on an element basis, Wi is the weight factor and Ve is 

the element volume. 

Finite volume method: In this method the flow volume is constituted of a number of 

small volumes and the discretization is based upon the integral form of the partial 

differential equations (governing equations). The governing equations are discretized 

such that they can be solved for every volume. The resulting equations obtained consist 

of fluxes of conserved variables. This method uses the conservative form of governing 

equations for discretization which ensures that the fluxes through each volume remain 

conserved. This method is useful for the fact that there is no limitation of using only a 

structured grid.  

 

Comparison of the three methods: All the three methods have found wide applications 

in their respective areas on the basis of the ease of applicability. Finite element method 

provides an end to end continuous solution but it requires lots of programming skills. 

Similarly finite volume methods are known to provide conservative solutions. Thus on 

the basis of the qualities and limitations of the three methods they can be chosen to be 

applied to a given problem. In the current work, Fluent is used as the analysis and 

simulation software package which is based upon the finite volume method. The 

discretization in Fluent/Gambit takes place by dividing the flow volume into a number of 

cells and each has their own volume. Thus the finite volume method comes into picture. 

Since the finite volume approach uses the integral form of conservation equations, the 



 42

equation of continuity expressed in the integral form for a steady and incompressible 

flow will be, 

                                                           ……… (3.12) 

Where S and n̂are the surface of the cell or control volume and the normal to 

the surface respectively. The above equation represents the net flow in and out of the 

control volume will be zero. For better interpretation it will be a good idea to look at the 

following figure. 

                            

    Fig. 3.1 Rectangular cell control volume (Source: CFD Introduction,   
   Bhaskaran and Collins) 

    

 The velocity on any face can be expressed as  

                                                                             (3.13) 

    Applying the conservation of mass on the cell control volume will result in 

another equation expressed as, 
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                                                  (3.14) 

     This equation is the equation of continuity applied to a single cell. It 

explains that the net mass flow in the cell adds to zero. The values at the cell centers are 

obtained by inverting the discrete system. The values of u1, v1, u2, v2 are obtained by using 

the interpolation technique on the cell center values at the adjacent cells. In this way the 

discrete equations for momentum and energy conservation can also be written. This is 

how Fluent incorporates finite volume analysis. 

3.4 Selection of turbulence model: 

A model is defined as a mathematical formulation of the physical and 

chemical aspects which define the process or product. This does not include the solution 

of these mathematical formulations. Simulations on the other hand are one of the 

activities that can be performed with the models. It involves solving a problem using an 

appropriate model. The observation of turbulent flows is a common phenomenon in 

various scientific processes that involve fluid motion. Turbulent flows have characteristic 

velocities that do not have stable behavior rather they are fluctuating in nature. These 

fluctuating velocities have a vital role to play in the continuity, momentum and energy 

transport equations. These quantities depict fluctuating characteristics which may vary in 

magnitude and frequency of fluctuations. Due to the variable nature of the quantities it 

demands a lot of computational power for calculation of these quantities. By calculating 

fluctuating quantities shorter length scales of turbulence can be resolved but it becomes 

extremely expensive in practical problems due to the amount of computational power 

needed. Such models are the Direct Numerical Simulation (DNS) and Large Eddy 

Simulation (LES) models. On the other hand, Reynolds averaged Navier Stokes models 
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(RANS) calculate average quantities. RANS models do not resolve all the turbulence 

scales. Fig.  3.2 shows the extent of modeling and resolving the turbulence scales in case 

of different modeling approaches. 

 

 

 

 

  Fig. 3.2 Extent of resolution of turbulence scales and modeling in different   
  turbulence models. (Source: BELL, B. Turbulent flow cases, Fluent Inc. 2003) 
 

 The selection of a turbulence model for a specific flow problem is based on 

dynamics involved in the problem, the computational power available, the time available 

for simulations, the particular practices prevalent for the kind of problem, and also the 

level of accuracy required. Fluent offers a wide variety of turbulence models and 

depending on the suitability of the model to the type of flow being considered, it can be 
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chosen to obtain the solution of the flow problem. The RANS models that Fluent offers 

consist of Spalart-Allmaras, K- and its variations, K-omega and its variations and 

Reynolds stress models (RSM). Fluent also offers the LES and DNS models but the 

current study does not necessitate talking about those models at length. In the current 

study we have used K- model and its variations which is a two equation model (K and 

 equations) which ensures that turbulent velocities and length scales can be determined 

independently. The assumptions used behind the model are that the flow should be fully 

turbulent and the molecular viscosity does not play a significant role in the flow. There 

are two other variations of this model namely RNG K- model and realizable K-. The 

RNG K-  and realizable K-  models have some modifications compared to standard 

K-  . To name a few, the RNG K-  model accounts for swirling effects on turbulence 

and has an extra term for rapidly strained flows in the  equation. Similarly the 

Realizable K-  model has an improved formulation for turbulent viscosity and a new 

equation for dissipation rate.  

 

   3.5 Modeling the multiphase flow: A phase can be defined as a particular       

distinguishable class of material that exhibits unique inertial behavior when interacting 

with the flow. A multiphase flow has more than one phase in the flow domain. In the 

present study liquid–solid flow is a concern. Some examples of liquid-solid are slurry 

flow, hydrotransport, sedimentation etc. The concentration in this study is on the slurry 

flows. There are two approaches with the help of which multiphase flow can be modeled. 

They are Euler-Lagrangian approach and Euler-Euler approach. Euler-Euler approach is 

of relevance in the present issue.  
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Euler-Euler approach: It is a fact that a phase cannot occupy the volume or content of 

another phase. Owing to this fact, in this approach the concept of volume fractions of 

different phases has been introduced. The phases are considered to be interpenetrating 

mathematically. Each phase has a volume fraction and the outcome of the addition of all 

volume fractions is unity. These volume fractions are considered continuous functions of 

space and time and are spatially and temporally dependent. Conservation equations for 

each phase are obtained to form a set of equations which is solved using constitutive 

relations. There are three different models under Euler-Euler approach. They are Volume 

of fluid (VOF) model, Mixture model and Eulerian model.  They are described in more 

detail in the following paragraphs. 

Volume of fluid (VOF) model: VOF model is generally used for two fluids that rarely 

mix with each other or rather are immiscible. The VOF model formulates a common set 

of momentum equations for all the fluids while each fluid has a different volume fraction 

equation and the volume fraction is calculated at each cell. The major applications of this 

model are involved in motion of large bubbles, steady or unsteady tracking of the liquid-

gas interface, prediction of jet break up, etc. 

 

Mixture model:  The mixture model is an Eulerian multiphase model which is suitable 

for the modeling of mainly solid particles and liquid fluids flowing together. The solid 

and liquid should be in strong coupling with each other. The mixture model aims at 

solving the momentum equations for the mixture. This model can model the phases 

which are moving with different velocities and hence slip velocity comes into existence. 

It uses the relative velocities to describe the secondary or dispersed phases. Mixture 
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model has an advantage that it is independent of the number of phases participating in the 

flow i.e. it can model any number of phases present in the flow. In this model one can 

select granular phases also and it enables us to find the properties of granular phases. 

Since in the current study particles are being dealt with therefore it makes the mixture 

model most suitable to be used as a multiphase model for the present work. All the 

related equations and concepts of the mixture multiphase model will be discussed in the 

next section. 

        

     Eulerian model: This model aims at solving different set of continuity and momentum 

equations for each phase involved in the flow. The coupling between the phases is 

obtained by using the pressure and interphase exchange coefficients. This induces higher 

degrees of complexities in this model. The granular and non-granular phases are treated 

differently and in case of granular phases kinetic theory is used to determine the granular 

properties. For handling the momentum exchange between the phases, user defined 

functions are employed. Using the Eulerian model any number of phases can be modeled 

but one thing to be considered is the availability of sufficient memory. Applications of 

this model include fluidized bed, particle suspension to name a few. 

 

      3.5.1 Modeling with Mixture multiphase model:  As has already been mentioned the 

mixture model uses only one set of continuity and momentum equations for the mixture 

as a whole and hence it uses less memory. Along with the merits of the mixture model 

there have been some limitations also. Just for example, while using mixture model one 

cannot use the density solvers in Fluent. Before moving to the governing equations used 
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in the mixture model it should be realized that apart from using common set of 

continuity, momentum and energy equations for the mixture, it solves the volume fraction 

equation for the secondary phases and algebraic expressions which pertains to the relative 

velocities if the phases are moving with different velocities. 

      3.5.2 Equations used in mixture model: The equations that are solved in the mixture 

model are the following.  

      Continuity equation- 
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 For kα being the volume fraction of kth phase. 

Momentum equations: The set of momentum equations solved in the mixture model are 

written as,    
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      Here Fn,  and mµ  are the number of phases, total body force and the viscosity of     

 mixture respectively and kdrv , is the drift velocity such that,  
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And             mkkd vvv −=,                                                                (3.20)             

 

      Energy equation:  The energy equation is given as, 

 

     (3.21) 

          

Where first and the second terms on the right hand side account for heat transfer owing to 

conduction and miscellaneous volumetric heat sources respectively. 

    And                        

    ( )( )∑ += tkkeff kkk α                                                                                       (3.22) 

is the effective conductivity. Subscript t in the conductivity tk  stands for the   turbulence 

and it is the turbulent conductivity and its value depends on the turbulence model. 

 

Slip velocity: In the mixture model the phases participating may have different   

velocities hence an algebraic slip formulation is employed in Fluent. So the expression 

for the relative velocity is given as,  

                                       qppq vvv −=                                                                 (3.23)                                          
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      Where  pv  and qv  are velocities of primary and secondary phase respectively. 

       The expression for drift velocity is stated as,   

           

                                                                            (3.24) 

       Where kc  is the mass fraction of any phase k expressed as, 

                                                                                                   (3.25)                               

       Studies reveal that slip velocity is a function of drag function, relaxation time, and 

acceleration of the particles of secondary phase (a ). When the flow is turbulent, slip 

velocity will also depend upon the dispersion due to the dispersed phase. Hence Fluent 

accounts for this by adding a diffusion term in the expression for slip velocity as shown, 

     

                                                      (3.26) 

 

      Where,  

      =mv Turbulent viscosity of mixture. 

      =dragf Drag function.  

      =Dσ  Prandlt dispersion coefficient. 

          In Fluent, there are several choices available for the drag functions. 
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Volume fraction equation for the secondary phase:  Volume fraction equations have   

been obtained from the continuity equation for the secondary phase. It is expressed as 

follows, 

                       (3.27)   

3.5.3 Limitations and assumptions of Mixture model: Along with the simplicity 

and ease of using the mixture model it has certain limitations also. Some of these 

limitations include the use of only the pressure based solver but not the density based 

one, inability for modeling inviscid flows and the flows involving solidification and 

melting. Mixture model cannot be used with some other models available in Fluent which 

include LES Turbulence model, shell conduction model, multiple reference frame (MRF) 

model (for relative velocity formulation) and Discrete Phase Model (when particles are 

tracked simultaneously). The mixture model is incapable for modeling streamwise 

periodic flows with constant mass flow rate and flows consisting of more than one 

compressible ideal gases. The mixture model uses the assumption of a local equilibrium 

between the participating phases in order to calculate the relative velocity between the 

participating phases. This local equilibrium is assumed to be limited to short length scales 

only.  

Apart from the mixture model being used in the current study, Eulerian model can 

also be a good simulation model. It can also be applied to the current problem. Eulerian 

model is the most complex multiphase flow model among all the three multiphase flow 

models. Eulerian model employs as many sets of momentum and continuity equations as 

the number of phases participating in the flow. In the current case there has been a wide 
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distribution of particles in the slurry. Owing to this fact, mixture model becomes more 

feasible over the Eulerian model. The disadvantage that Eulerian model carries is that it 

demands a lot of computational power. This is also one of the reasons for preferring the 

mixture model over the Eulerian model.   

 

3.5.4 K-ε  Equations used in mixture model: K- ε  turbulence mixture model has been 

used which is by default employed in Fluent when multiphase flow is combined with 

turbulence. It is suitable for stratified flows.  Following are the K andε  equations used in 

capturing the relevant characteristics, 

                             (3.28) 

       And     

                       (3.29) 

 Where,     

                ,                                                                             (3.30) 

                                                                                           (3.31) 

Turbulent viscosity, 

                                                                                          (3.32) 
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       And turbulent kinetic energy production is given by, 

                                                     (3.33) 

3.6 Incorporation of sensor and pipe geometry using Gambit meshing and   

formulation: 

FTIR probe description: The Fourier Transformed Infrared Reflectance (FTIR) probe 

consists of a cylindrical section with a gap or slot through its curved surface. The sensing 

is performed across this slot. The sketch of the probe is shown in the Fig. 3.3. All the 

dimensions are shown in the figure except one which shows the variable part of the probe 

whose dimension can be varied in order to vary the slot dimensions. 

                       

 Fig. 3.3 Fourier Transformed Infrared Reflectance probe 
 

 

The pipe that has been considered for different cases is 7.112 m in length and 

0.1016 m in diameter. The probe is placed at distance of 4.064m from the inlet and is 

3.048m before the outlet. The Reynolds number of the flow is of the order of 240,000. 
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In order to design the probe and pipe assembly in Gambit, coordinates of vertices 

have to be entered using Operation->Geometry->Vertices. After entering the vertices, 

edges have to be constructed through Operation->Geometry->Edge by using two or more 

vertices. These edges can be linear, circular or arc. Further edges created will be used for 

making faces of the assembly design through Operation->Geometry-> Face. And at last 

by using Operation-> Geometry->Volume, faces are either stitched or swept to obtain 

three dimensional geometries. It should be pointed that Stitch and Swept are two 

command options in Gambit used to make a volume by stitching multiple faces or 

sweeping one single face in a direction perpendicular to it and the swept region is 

converted to volume. For the current case the pipe has been designed in three volumes in 

inlet, outlet and probe regions. 

The next step which is the most important step of the design is the mesh 

generation or grid formation in the constructed geometry. For the current design 

Operation-> Mesh-> Mesh volumes have been used. The volume in the probe region has 

been meshed using the tetrahedral grid meshing with the interval count of the grid points 

on the faces being 10. The inlet and outlet volume regions have been meshed using 

hexagonal cooper meshing scheme available in Gambit with an interval count of 40. The 

total number of cell volumes formed after meshing are 0.68 million. A plain pipe is also 

designed in order to determine the results of fully developed flow. It has been meshed 

using the hexagonal cooper scheme and interval count of 50. 

The last step of the design process is the specification of boundary conditions. 

Following Operation->Zones->Specify Boundary Types, desired boundary conditions 
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can be specified in Gambit. The boundary types specified in the current case are Velocity 

inlet, Pressure outlet, Wall. Figure shows the boundaries specified. 

 

Fig.  3.4 Boundary types shown in Gambit 

After when all the above steps are successfully implemented we can expect a meshed 

geometry similar to as shown in the Fig. 3.5 

 

Fig.  3.5 The meshed pipe and probe assembly in Gambit. 
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The meshed geometry is then saved using File--> Save. Further, the meshed 

geometry will have to be exported using File-> Export-> Mesh to Fluent where the actual 

analysis will take place. This will save a .msh file in the Gambit working folder. 

3.7 Simulations in Fluent:  Proceeding with the next stage of the work done in Gambit, 

click on the Fluent icon to open Fluent. While opening Fluent, 3ddp (Three dimensional 

double precision) version has to be selected in Full simulation mode. First, the .msh file 

exported in Gambit is imported in Fluent using File-> Read-> Case.  Next the Grid has to 

be checked for discrepancies, if any. This is done using Grid-> Check.  Further the 

problem is set in Fluent by defining the models and input values of the relevant variables. 

Using the Define panel solver being used, the multiphase model employed and the 

turbulence model are specified as Define-> Models-> Solver, Define-> Models-> 

Multiphase and Define-> Models-> Viscous respectively. For the present study, pressure 

based solver, multiphase mixture model and turbulence K-ε  models have been utilized. 

When mixture model is selected, the user has to specify the number of phases involved in 

the flow, slip velocity computation if required and any implicit body forces if acting 

during the flow. The current study makes use of both slip velocity as well as implicit 

body force which is gravity in this case. Moving ahead the solid and liquid phase 

materials which are being used in simulation process are selected using Define panel as 

Define-> Materials. Generally all the materials are available in Fluent database but user 

can input the materials by adding the name of material along with the required properties. 

In this case the Table 3.1 shows the input values of the liquids and solid particles. There 

are two different cases for which two different sets of materials are used. 
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MATERIAL DENSITY 

(in kg per cubic 

meter) 

VISCOSITY (in Kg per 

second meter) 

CASE I 

2-Amino-4,6-

dimethylpyrimidine (ADP) 

particles. 

1480 - 

Xylene (Liquid) 870 6.2e-04 

CASE II 

Calcium carbonate particles. 2800 1.72e-05 

Water 998.2 1.003e-03 
 
                                                Table 3.1 Input materials in Fluent 
 

MATERIAL PHASE 

CASE I 

2-Amino-4,6-dimethylpyrimidine 

(ADP) particles 

 

Secondary 

Xylene                                                           Primary 

CASE II  

Calcium carbonate particles. Secondary 

Water Primary 

                                     

                                            Table 3.2 Input materials phase in Fluent                       
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Using Define-> Phase, one has to define the primary and secondary phases along 

with their state. Table 3.2 above indicates the phase of the materials used. 

For the secondary phase, granular characteristics have been chosen in all the 

present cases. Further through the Define panel one can choose to select the interactions 

between the phases which include specifying the drag functions, slip velocities etc. Using 

the Define panel, Operating conditions and Boundary conditions are provided using 

Define-> Models-> Operating conditions and Define-> Boundary conditions respectively.  

In the Operating conditions panel the gravity check box has to be selected and its value is 

given in Y direction as -9.81m/sec2. In the Boundary conditions panel different input 

values have to be provided at different boundaries. Table 3.3 gives a better explanation of 

the input variables and their values in the current case. The turbulent intensity of the flow 

is calculated using the following formula which depends upon Reynolds number                  

                                                                                         (3.34) 

 The backflow turbulent intensity is one of the parameters that need to be input. 

Backflow turbulent intensity refers to the intensity of turbulence if there is any flow 

taking place in the reverse direction. Backflow parameters are used by Fluent if 

any backflow occurs during the iterations, otherwise they are not used. A good guess of 

these parameters will help the solution to run stable if backflow occurs, a bad guess can 

cause divergence also. 
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Boundary 

types 

Primary phase 

input values. 

Secondary phase 

input values. 

Mixture input 

values 

Inlet (Velocity 

inlet) 

Flow velocity of 

liquid phase 

=2m/sec. 

Flow velocity of 

particle phase 

=1.5m/sec. and 

volume fraction 

=0.4 

Specification 

method 

(Turbulent 

intensity= 3.5%. 

and hydraulic 

diameter 

=0.1016m) 

Outlet (Pressure 

outlet) 
None. 

Backflow volume 

fraction =0.4 

Specification 

method (Back 

flow Turbulent 

intensity= 

0.001%. and 

hydraulic 

diameter 

=0.1016m) 

Wall None None. Default values 

Fluid None None 
Rotation axis 

direction Z=1. 

          

                           Table 3.3 Input variables and their magnitudes. 
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Further the solution parameters are provided using the Solve panel. Solve-> Controls- 

>Solution controls is used to open the Solution controls panel where the under-relaxation 

factors, pressure-velocity coupling types and discretization laws are specified. For the 

current problem as the geometry is complex due to presence of the probe in the flow, 

hence first order upwind discretization is preferred for all the quantities. One can play 

with the underrelaxation factors in order to govern the convergence of the residuals. The 

next step involves the solution initialization using Solve -> Initialize-> Solution 

initialization. In the current case solution is initialized from inlet. In the next step, 

convergence criteria are mentioned for all the variables using Solve -> Monitors-> 

Residuals. Generally it is set at 1e-5 or smaller. Also one has to activate the plot option to 

enable Fluent to plot residuals. Next step is the one in which iteration parameters like 

time step size, numbers of time steps, numbers of iterations per time step are specified for 

a transient flow problem. This is done using Solve -> Iterate-> Iterate. For the present 

work the time step size has been taken of the order of 0.1. Then iterations are performed 

to achieve convergence of residuals. 

 Fluent follows an iterative scheme to find the solution of the flow problem. All 

the governing equations are solved for each and every time step. This is done until the 

convergence is achieved in every time step. Once the convergence is obtained in a time 

step the solution is increased by one time step. This can be expressed as shown in Fig. 

3.6. This scheme also considers the non-linear nature of the governing equations as well 

as the inter-relation between the equations.  
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        Fig. 3.6 Solution strategy in Fluent (Source: Fluent 6.3 user guide) 

  Fluent offers versatile post processing tools to visualize and analyze the flow. 

These tools include XY plots, contour plots, vectors displays etc which can be found 

under the Display and Plot panels. Post processing has been done and fairly good results 

have been obtained which have been dealt with in the next chapter. 
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CHAPTER IV 
 
 

Results and Discussion 

 

4.1 Brief recapitulation:  

It has been discussed in the preceding chapters that Computational Fluid 

Dynamics is playing an important role in predicting the characteristics of the multiphase 

flow involving liquid and solid particles. In the current study CFD has been applied to the 

flow of a chemical slurry in which 2-Amino-4, 6-dimethylpyrimidine (ADP) is used as 

particles and Xylene is the liquid. In a different case, calcium carbonate particles were 

made to flow through water forming calcium carbonate-water slurry. The flow has taken 

place through pipes with the ratio of length to diameter being 70. The modeled Fourier 

Transform Infrared reflectance probe is placed such that its distance from the inlet is 

more than that from the outlet of the pipe vertically on the upper surface. The probe is at 

a distance 40 times the diameter from the inlet and 30 times the diameter from the outlet. 

 This chapter aims at presenting the important findings of the current research. It 

has been mentioned that the current research focuses on the application of CFD to 

visualize the flow over and through the sensing gap of the FTIR/NIR probe. It also aims 

to determine the profiles of solid particle concentration and velocity through the sensing 

gap of the probe. The post processing tools of Fluent have been utilized in order to ensure 

self explanatory and descriptive visualization of the flow. In addition,
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Tecplot 260 has been employed for plotting the concentration profiles and velocity 

profiles of slurry flowing through the sensing gap of the probe. The results obtained by 

using ADP particles and Xylene are compared with those with the calcium carbonate 

particles and water. In all the plots shown all distances are in meters and negative sign 

on Z velocities represents direction as the slurry is flowing in the negative Z 

direction. 

4.2 Flow of Xylene (WITHOUT particles) in 7.112m length pipe: In this section, the 

results obtained by the flow of xylene in a plain pipe (pipe with no probe) are presented. 

The inlet velocity is 2m/sec. The profiles of Z velocity of xylene have been plotted along 

different axes. The velocity profiles clearly depicts that fluid flow shows the fully 

developed behavior. 

-Z velocity variation along the centerline: 

 The pipe coordinate system is shown in Fig. 4.1(a). Fig. 4.1(b) shows the Z velocity 

variation. The centerline Z-velocity increases as the fluid flow takes place further the 

inlet. Then it decrease and gradually becomes constant. This shows that the flow has 

become fully developed. 

 

                                                                        (a)  
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                                                                       (b) 

 Fig. 4.1 (a) Pipe coordinate system (plain pipe) (b) Z velocity of Xylene varying  
 along centerline of the pipe.  
 
-Z velocity profiles along the vertical axis along Y direction: 

      

 Fig. 4.2 Pipe section showing the location of planes and the respective axes along 
 which Z velocity are plotted. Inlet (hown in blue) is near Z= -1 plane and oulet 
 (shown in red )lies near to Z= -7 plane. Flow direction shown by arrow. 
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(a)                                      (b)                                        (c)                                                                        

          

                                (d)                                                                   (e)                                                         

  Fig. 4.3 Z velocity profiles along vertical axes in (a) Z= -1 (Z/D=9.84), (b) Z=- 2 
 (Z/D=19.685), (c) Z= -3.5 (Z/D=34.45), (d) Z= -5 (Z/D=49.2) and (e) Z= -7(Z/D=
 68.89) cross sectional planes as shown. 
 
 Fig. 4.3 shows the Z velocity profiles of Xylene along the vertical axes lying in 

different cross sectional planes normal to the axis of the pipe. The profiles shown in (a) 

(b), (c), (d) and (e) are all symmetric with respect to the centerline which is at y/R=0.  

 The comparison of power law profile for a turbulent plain pipe flow with the non 

dimensional velocity profiles is shown in Fig. 4.3(f). The inlet velocity is 1.5m/sec. The 

profile in blue is obtained from Fluent while the one in red is the power law profile. The 

power law index is 7. The agreement of the profiles is as shown in Fig. 4.3(f). The power 

law index has been taken from Schlichting (1968). 
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 4.3 (f) Comparison of velocity profile in radial direction with power law profile 
 (n=7) shown in red with the fluent profile in blue at Z/D=35. 
 

Z velocity profile along the centerline of a plain pipe WITH particles: 

Fig. 4.4 shows the particle Z velocity profile along the centerline of the plain pipe. The 

particle diameter is 100 microns. Thus in the presence of particles the flow gains fully 

developed characteristics at around Z/D= -35. Hence placing the probe at Z/D=-40 is 

worthwhile in order to mount the probe in fully developed flow region. 

                    

 Fig. 4.4 Particle Z velocity profile along centerline of the plain pipe.     
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                                                             (a1) 

4.3 Flow of ADP particles with Xylene in 7.112m (L/D=70) length pipe: 

In this section, the data obtained by the simulation of the flow of ADP particles and 

Xylene have been presented. The data has been presented in the form of plots, contours 

and vectors of different physical quantities. These quantities are Z-velocity and volume 

fraction of particles. In order to study the variation of these quantities in particular 

directions, different lines and planes have been drawn using Fluent post processing tools 

and then the corresponding physical quantity has been plotted against that line/plane. The 

pipe dimensions can be expressed in terms of cylindrical coordinates R, θ and Z where R 

is the radius of pipe, θ being the angular distance and Z being the pipe axis corresponding 

to the length of the pipe. In the current case R varies from -0.0508 m to 0.0508m, θ varies 

from 0 to 360 degrees and Z varies from -3.048 m to 4.064 m. Hence the geometry is 

asymmetrical with respect to Z coordinate. The position of origin is shown in Fig. 4.5(a) 

as (0,0,0). 
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4.3.1 Plots of velocity profiles: Velocities have been plotted along the axial (Z/D) and 

radial (y/R) directions and the conclusions have been drawn. The pipe length ranges from 

inlet at Z/D=40 and outlet at Z/D= -30 (negative Z direction) with probe at Z/D=0. Y 

coordinate varies from y/R= -1 to +1. The axes along which the velocity profiles have 

been plotted are shown in the adjacent figures. 

-Particle Z velocity vs. axis (centerline): The axial velocity (Z velocity) has been 

plotted along the centerline or the axis of the pipe as shown in Figs 4.5. Fig. 4.5(a2) 

shows the axis along which the velocity has been plotted. Fig. 4.5(b) depicts the variation 

of Z velocity of particles along the centerline of the pipe. The negative sign on the 

velocity is indicative of the direction of flow as the flow is in negative Z direction. The 

particle Z velocity at injection is -1.5 m/sec which suddenly reaches to -1.73 m/sec when 

comes in contact with the liquid Xylene which has initial velocity of -2m/sec. Thus -1.73 

m/sec is the initial velocity of the slurry. The particle Z velocity increases and then comes 

down to the previous magnitude of -1.73 m/sec as the flow progresses after the inlet. The 

flow is smooth and the particle Z velocity remains constant till it reaches the vicinity of 

probe where major fluctuations in the particle Z velocity are observed as shown in Fig. 

4.5(c). The particle Z velocity in the probe region shows a zigzag variation. This is 

attributed to the divergence of the flow in the presence of probe. The fluctuations in Z 

velocity may be observed owing to 3D flow in y direction (increment in Y component of 

velocity) as the particles will have the tendency to flow downwards as the probe is 

approached. After the probe region the particles regain the same velocity magnitude. As 

the flow approaches the outlet there is a very little decrease in the particle Z velocity. At 

the outlet the particle Z velocity has the same magnitude of -1.73m/sec.                                      
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                                                                  (a2) 

                         

                                                                        (b)    
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                                                                        (c) 
 
 Fig. 4.5 (a1) Probe and pipe assembly with the directional coordinate system (a2) 
 Axis of the pipe (b) Particle phase Z velocity variation along the centerline (c)Flow 
 along the probe vicinity shown between parallel lines. 
 
 
-Particle Z velocity vs. axis parallel to the centerline and passing through the middle 

of probe slot: Fig. 4.6 shows the variation of the particle Z velocity along the axis 

parallel to the centerline and passing through the middle of the probe slot as shown in 

Fig. 4.6(a). The negative sign on the velocity is indicative of the direction of flow as the 

flow is in negative Z direction. Along this axis, a similar behavior of particles is observed 

as along the centerline but as the flow progresses from inlet the particle Z velocity 

undergo a little decrease in the magnitude and then becomes uniform until it reaches the 

vicinity of probe slot. Again the major fluctuations in velocity of particles are observed in 

the probe slot vicinity which is shown in Fig. 4.6(c). After the probe slot vicinity the 

particle Z velocity starts climbing up to regain the previous velocity. Unlike the variation 

along the centerline of the pipe, the particles travel more distance in the pipe to regain the 

same velocity as shown in Fig. 4.6(c). As the flow approaches the outlet the particle Z 

velocity decreases and ends up at a magnitude of 1.5m/sec. 
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                                                                     (a) 

      

                                                                        (b) 

        

                                                                         (c) 
  Fig. 4.6 (a) Axis (b) Particle phase Z velocity variation along the axis parallel to the 
 centerline. (c)Flow along the probe vicinity shown between parallel lines. 
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-Particle Z velocity vs. axis parallel to the centerline and passing through the lower 

solid part of probe: Fig. 4.7 shows the variation of particle Z velocity along an axis 

parallel to the axis of the pipe but passing through the lower solid end of the probe. The 

particle Z velocity before reaching the probe region behaves similar to the velocity 

observed along the centerline of the pipe. When it reaches the vicinity of lower solid end 

of the probe there is immediate drop in velocity to null value due to the presence of 

              

                                                                      (a) 

      

                                                                     (b) 
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                                                                         (c) 
 Fig. 4.7(a) Axis. (b) Particle phase Z velocity variation along the axis parallel to the 
 centerline but passing through the lower solid end of the probe. (c)Flow along the 
 probe vicinity shown between parallel lines. 
 
stagnation point as shown by the curve. Further downstream, the particles attain the usual 

velocity again which is of the order of -1.73m/sec. The particle Z velocity fall gradually 

and then becomes uniform as the outlet is approached as shown. 

  In all the three cases of variation of particle Z velocity (Figs. 4.5(b), 4.6(b), 

4.7(b)) it can be noticed that the velocity profile in the region before the probe (Entrance 

region of pipe) is similar to the profile in the entrance region of the plain pipe with 

particles (Fig. 4.4) except in the above three cases uniform velocity is achieved earlier 

Z/D value. 

-Particle Z velocity along Y axis (i.e. Along the line through the center of the probe 

slot circular section and the lines to the left and to the right of it as shown in the Fig. 

(a)): The variation of particle Z velocity is shown in Fig. 4.8 (b) along the line through 

the center of the probe slot circular section using the purple □. The negative sign just 

indicates the direction of flow. The probe slot lies between y/R= 0.5 to y/R=0.75 with 
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center of slot at y/R=0.625. The points shown explain that the velocity of the particles is 

zero at the upper and lower surface of the probe slot. The particle Z velocity profile 

resembles a parabola along the axis through the center of the probe slot.  

 Fig. 4.8(b) also shows the variation of particle Z velocity along the axis parallel to 

the Y axis but to the left of it. It is expressed as green triangle ►. There are small 

variations in the particle Z velocity near the center of the probe slot as shown by the 

points near the center. They exhibit very small velocity difference. 

 
 

    

                         Left                                      (a)                                         Right   
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                                                                         (b) 
 Fig. 4.8(a) Axes in Y direction and along the lines to the left and to the right of it 
(b)Particle Z velocity vs. Y axis (Along the line through the center of the probe slot 
circular section, along the lines to the left and to the right of it. 

 
  

 The variation of particle Z velocity along the axis parallel to the Y axis but to the 

right of it is also depicted in Fig. 4.8 (b) using blue ∆.  The velocity at the lower and 

upper walls of probe slot is zero. In this case also, the variation resembles a parabola but 

this time density of velocity points is more near the center of the probe slot. Here the 

profile defines more curvature near the center compared to the profile obtained for the 

axis on the left.               

4.3.2 Plots of particle volume fraction: This section will focus on the variation of the 

volume fraction of the particle phase along different axes. This information can be used 

to predict the particle concentration profiles through the probe slot.  
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- Particle volume fraction along Y direction (i.e. Along the line through the center of 

the probe slot circular section and the lines to the left and to the right of it as shown 

in the Fig. (a)): Fig. 4.9 (b) shows the variation of particle volume fraction along the 

lines through the center of the probe slot circular section in Y direction and axes to the 

left and to the right of it as shown in the Fig. (a). The Y axis shows the axis considered 

with specification as non-dimensional distance y/R while the X axis has the particle 

volume fraction.  

 

    

                              Left                                 (a)                               Right 
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                                                                      (b) 
Fig. 4.9(a) Axes in Y direction and along the lines to the left and to the right of it (b) 
Particle volume fraction vs. Y axis (Along the line through the center of the probe 
slot circular section, along the lines to the left and to the right of it. 
 

  The variation in volume fraction is of the order of 10-3 which can be neglected. 

Hence the volume fraction of particles can be considered constant along the considered 

axis. Even though the particle volume fraction is constant, of the three cases the profile 

obtained for the axis considered on the ‘axis through probe slot left’ accounts for 

maximum variation. 

- Particle volume fraction along an axis parallel to Y direction but behind it: 

The axis is shown in Fig.  4.10 (a) with a red line. Fig. 4.10(b) shows the variation of 

volume fraction along the axis parallel to Y axis but behind it as shown by the red line in 

Fig. 4.10(a). It can be inferred that volume fraction decreases as we move from upper 

wall of the probe slot (y/R=0.75) to lower wall (y/R=0.5). But the magnitude of variation 
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is of the order of 0.001 hence it can be said that volume fraction is nearly constant along 

the considered axis.  

 

              

                                                                      (a)                        

  

  Fig. 4.10(a) Axes. (b) Particle volume fraction variation along the axis  
  behind  the Y axis through probe.  
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- Particle volume fraction along an axis parallel to Y direction but in front of it: Fig. 

4.11 shows the variation of volume fraction along the axis parallel to Y axis but in front 

of it as shown by the green line in Fig. 4.10(a). It can be inferred that volume fraction 

decreases more steeply in the center of slot as we move from upper wall of the probe slot 

(y/R=0.75) to lower wall (y/R=0.5). But the magnitude of variation is small and is of the 

order of 0.001. Hence it can be said that volume fraction is nearly constant along the 

considered axis.  

                       

 Fig. 4.11 Particle volume fraction variation along the axis in front of Y axis 
 through probe. The axis is shown in Fig. 4.10 (a). 
 
-Comparison of particle volume fraction along the axes shown in Fig. 4.10(a): 

Fig. 4.12 shows the comparison of variation of volume fraction along the three different 

axes as shown by red, black and green lines in Fig. 4.10(a). Though by minute amount, 

but for comparative study the volume fraction magnitude is highest for the variation 

along the axis to the front of Y axis (Shown by green in Fig. 4.10(a)). The volume 
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fraction is lowest along the axis shown in red in Fig. 4.10 (a). This is because the axis 

shown in red is nearest to the vertical wall and since probe slot has opening just opposite 

to the wall so a three dimensional flow also takes place. Thus the axes farther from the 

vertical wall of the probe slot have comparatively more volume fraction magnitude.  

                 

 Fig. 4.12 Particle volume fraction variation along the axes shown in Fig. 4.10 (a). 
 
 
4.3.3 Z velocity of slurry/mixture along the vertical and horizontal (axial) axes. 
 
 
-Z velocity of slurry/mixture along the vertical axes in Z=3, 2, 1,-1,-2 planes: 

Fig. 4.13 shows the variation of particle Z velocity along a vertical axis in Z=3 cross 

sectional plane as shown by the blue circular section in the probe and pipe assembly in 

the Fig. 4.13 (a). The end points of the axis lies at y/R = -1 to y/R = 1. The curvilinear 

profile obtained is asymmetric with respect to the centerline of the pipe which at y/R=0.  
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                                                            (a)  

     

                                                                      (b) 

 Fig. 4.13(a) Probe and pipe assembly with the planes Z=3, 2, 1,-1,-2 (left to right) (b) 
 Particle Z velocity along a vertical line in the cross sectional plane Z=3, 
 Z/D=29.527 



 82

 

 Fig. 4.14 Particle Z velocity along a vertical line in the cross sectional plane  Z=2, 
 Z/D=19.685. 
  

 Fig. 4.14 shows the variation of particle Z velocity along a vertical axis in Z=2 

cross sectional plane as shown by the violet circular section in the probe and pipe 

assembly in the Fig. 4.13(a).The end points of the axis can be shown at y/R = -1 to y/R = 

1. Again the velocity distribution is asymmetric with respect to centerline of pipe which 

is at point y/R=0. This may be due to the effect of gravity on particles. 

 Fig. 4.15 depicts the variation of particle Z velocity along a vertical axis lying in 

Z=1 cross sectional plane as shown by orange circular section in Fig. 4.13 (a). The axis 

lies along y/R = -1 to y/R = 1. The velocity distribution is less asymmetric with respect to 

centerline of pipe (y/R=0) compared to the distributions in the planes nearer to the inlet 

shown in Figures 4.14 and 4.13(b). Also notice that the velocity at centerline (y/R=0) is 

about -1.75 m/sec.  
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 Fig. 4.15 Particle Z velocity along a vertical line in the cross sectional plane  Z=1, 
 Z/D=9.84. 
  

 Fig. 4.16 shows the variation of particle Z velocity along a vertical axis in Z= -1 

cross sectional plane as shown by the green circular section in the probe and pipe 

assembly in Fig. 4.13(a). The end points of the axis can be shown at y/R = -1 to y/R = 1. 

The variation is found to be symmetric with respect to the centerline at point y/R=0. The 

Z velocity is almost 1.75 m/sec. Since the velocity has become constant, hence this marks 

the presence of fully developed characteristics in the flow. It can be seen that the above 

results (Fig. 4.13- 4.16) are in agreement with the findings of Lin et al (2007). Here also, 

the maximum velocity location is moving vertically up as we move downstream. 

 The variation of particle Z velocity along a vertical axis lying in Z= -2 cross 

sectional plane is shown by white circular section in Fig. 4.17. It is found that little 

asymmetricity with respect to the centerline at point y/R=0 has been introduced. This 

may be due to the presence of gravity. Again the Z velocity at the centerline (y/R=0) is 

found to be almost -1.75 m/sec which shows that now Z velocity can be considered 
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nearly constant along the centerline.        

 

 Fig. 4.16 Particle Z velocity along a vertical line in the cross sectional plane  Z=-1, 
 Z/D= -9.84. 

 

 Fig. 4.17 Particle Z velocity along a vertical line in the cross sectional plane  Z=-2, 
 Z/D = -19.685 
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-Z velocity profiles along the axes parallel to Z direction passing through probe slot: 

Z velocity profiles along the lines through the probe slot and parallel to Z 

direction are shown in Figs 4.18. Lines 1, 2, 3 4, and 5 are distributed from upper to 

lower walls of the slot as shown in Fig. (a’). Hence velocity variations along lines 1 and 5 

are very close to zero as they are very near the probe walls. Velocity variations along the 

lines 2, 3 and 4 which are away from the walls are larger in magnitude. Among all the 

variations the highest velocity is found along the line 3 (Fig. (c)) which is the centerline 

of the probe slot and is farthest from the walls. 

 

 

                                                                         (a’) 

             
                                                                          (a) 
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                          (b) 

     
                                                            (c) 
 

      
                      (d)                                                                     (e) 
 
Fig. 4.18(a’) Axes. Particle Z velocity profiles through probe slot along the axial slot 

 lines (a)Slot line 1, y/R= 0.74 (b) Slot line 2, y/R= 0.69(c) Slot line 3, y/R= 0.625 
 (d) Slot line 4,  y/R=0.56 (e) Slot line 5, y/R=0.51.  
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-Particle volume fraction profiles along the lines parallel to Z direction and passing 

through probe slot: Z velocity profiles along the lines through the probe slot and parallel 

to Z direction are shown in Fig. 4.19. The volume fraction variation along these lines are 

of very small magnitudes and can be assumed nearly constant. However, for comparative 

study it can be found that the variation of volume fraction along the lines which are 

nearer to lower wall of probe slot is smaller. This may be due to the effect of gravity on 

particles at higher elevation from lower wall. That is why volume fraction decreases 

along the axes which are away from lower wall of probe slot. 

 

Fig. 4.19 Volume fraction profiles along the axial lines through probe slot. 
 

4.3.4 Visualization of the flow of ADP particles with Xylene: Post processing tools 

available in Fluent have been utilized to visualize the flow of the slurry of ADP particles 
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and Xylene over the probe. Vector and contour plots concerning different quantities are 

presented.  

-Contours of Z velocity of slurry/mixture along the plane Y=0.02: 

 

                                                                  (a)  

 

       Fig. 4.20(a) Plane Y=0.02 (b) Contours of Z velocity of slurry along the plane 
 Y=0.02, Y/R=0.39. 
 
Fig. 4.20(b) shows the contours of Z velocity along the horizontal plane that passes 

through the lower solid portion of the probe as shown in Fig. 4.20(a). The contours of 



 89

velocity show that the velocity is maximum on the sides of the probe while it is minimum 

on the front and the back of the probe solid cylindrical portion. 

- Contours of Z velocity of slurry/mixture along the plane Y=0.03:   

 

                                                                     (a) 

 

            Fig. 4.21(a) Plane Y=0.03(b) Contours of Z velocity of slurry along the plane Y=0.03,  
 Y/R=0.59 
 
Figure 4.21(b) shows the contours of Z velocity along the horizontal plane that passes 

through solid portion of the probe at the solid semi-circular part adjacent to slot of the 
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probe as shown in Fig. 4.21(a). Again the Z velocity is maximum on the sides of the 

probe and minimum on the front and the back of the probe solid portion as shown. 

-Contours of Z velocity of slurry/mixture along the plane X=0:  

Fig. 4.22 shows the contours of Z velocity of slurry along the vertical plane X=0 with far 

view. The velocity starts to rise again in vertical direction after it crosses the probe. This 

is shown with the dark blue flow contours. 

 

            Fig. 4.22 Contours of velocity Z velocity of slurry along the plane X=0 (X/R=0) 
 which the passes right in the middle through the probe section as well as the probe 
 slot. 
 

 

A closer view of contours along the vertical plane X=0 is shown in Fig. 4.23. The 

contours show the flow behavior such that after crossing the probe the velocity rises 

vertically and then falls further downstream as it approaches the outlet of the pipe. The 

dark blue velocity contours show this behavior. 
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 Fig. 4.23 Contours of Z velocity of slurry along the plane X=0 (closer view) 
 
 Fig. 4.24 depicts the Z velocity contours in the probe slot vicinity. The contours 

show that the velocity near the walls of the probe and that of the pipe is zero. The 

variation of contour colors in the probe vicinity defines the profiles of variation of Z 

velocity in the probe region. The contours clearly show that there is an abrupt increase in 

Z velocity when the flow is about to enter the probe slot region. 

 

 Fig. 4.24 Contours of velocity Z velocity of slurry along the plane X=0, closer 
 look of  probe region. 
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-Contours of Z velocity of slurry/mixture along the plane X=0 passing through the 

probe slot: Velocity contours are considered for a plane through the probe slot shown in 

Fig. 4.26.The plane has been separately shown in Fig. 4.25. The plane passes through the 

slot of the probe and is shown in grey with the probe shown in green.  

 
 
 Fig. 4.25 Vertical plane passing through the probe slot shown in grey with the 
 probe shown in green. 
  
 The velocity near the wall is zero which is shown with red. Moving away from 

the wall the velocity increases and is maximum in the central portion of the probe slot. 

The central region of the probe slot having higher magnitudes of velocity decreases as the 

flow reaches the end of the probe slot. This can be shown clearly with the region in the 

dotted box on the right which is less in height than the one on the left. This may be due to 

the growth of the boundary layer on the upper and lower walls of the probe slot. It can be 

seen in the portion marked inside the box in Fig. 4.27. As the slot is open from one side 

hence there will a three dimensional flow. This may result in the fall of Z velocity 

magnitude. 
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 Fig. 4.26 Contours of velocity magnitude of slurry/mixture along the plane  X=0, 
 X/R=0 which passes right in the middle of the probe slot. 
 
Contours of Z velocity of slurry/mixture along the plane Z=0 plane passing through 

the probe slot: Fig. 4.27 shows the variation in Z velocity of slurry with help of contours 

along Z=0 plane (Z/D=0). The contours depict the region of maximum velocity away 

from the wall region of the pipe and the probe. 

                        

         Fig. 4.27 Contours of Z velocity of slurry/mixture along the plane Z=0, where 
 Z/D=0 
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-Contours of particle volume fraction in the plane X=0:  

 

 Fig. 4.28 Contours of velocity colored by particle volume fraction in the plane 
 X=0, where X/R=0. 
 
Fig. 4.28 shows the distribution of particle volume fraction along the vertical plane X=0 

which passes through the probe region. The distribution of volume fraction is curvilinear 

in nature. Later on as the flow moves away from the probe region the profiles of volume 

fraction variation start losing the curvature and tend to become vertical and tend to 

become normal to the centerline of the pipe. 
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4.3.5 Comparison of Volume fraction profiles obtained for two different particle 

sizes: This portion presents the results obtained by using different particle size. Particles 

of ADP with diameters 100 and 400 micrometers were considered. Volume fraction 

profiles along the axes through the probe slot as discussed previously are plotted.   

- Comparison of volume fraction along Y axis lying in the probe slot: 

The volume fraction magnitude for 400 micron particles is slightly less than that 

for 100 micron particles along the vertical axis between the circular sections of the probe 

slot. This can be easily inferred from Fig. 4.29 which is owing to more apparent weight 

of 400 micron particles. 

 

  Fig. 4.29 Comparison of volume fraction along Y axis lying in the probe slot. 
 
Comparison of volume fraction along line parallel to Y axis lying in the probe slot 

but to the left of it: Fig. 4.30 show the volume fraction magnitude along line parallel to 

Y axis lying in the probe slot but to the left of it for 100 and 400 micron particles. Again, 
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the 400 micron particles exhibit lower volume fraction than 100 micron particles. This is 

owing to more apparent weight of 400 micron particles. 

 

 Fig. 4.30 Comparison of volume fraction along line parallel to Y axis lying in the 
 probe slot but to the left of it. 
 

Comparison of volume fraction along line parallel to Y axis lying in the probe slot 

but to the right of it: Fig. 4. 31 show the volume fraction magnitude along line parallel 

to Y axis lying in the probe slot but to the right of it for 100 and 400 micron particles. 

The volume fraction for both the particles is constant along the considered axis. This time 

also, the 400 micron particles have lower volume fraction than 100 micron particles along 

the considered axis. This is due to to more apparent weight of 400 micron particles as 

apparent weight of particles is directly proportional to their diameter. 
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 Fig. 4.31 Comparison of volume fraction along line parallel to Y axis lying in the 
 probe slot but to the right of it. 
 

- Particle volume fraction along axes parallel to Y direction but are behind and in 

front of it: Fig. 4.32(b) and (c) shows the comparison of volume fraction variation of 100 

and 400 micron particles along the axis shown in red and green respectively in Fig. 4.32 

(a). In this case also, the physics of more apparent weight of 400 micron particles than 

100 micron particles holds good. Hence the volume fraction magnitude for 100 micron 

particles is more than the 400 micron particles ones. Here also the magnitude of volume 

fraction can be considered constant along the axes shown in Figs 4.32. 
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(a) 

                 

 

                           (b)                                                                     (c) 
 Fig. 4.32 (a) Axes along the probe slot (b) Comparison of volume fraction along line 
 parallel to Y axis but behind it (shown by Red line in Fig. (a)). (c) Comparison 
 of volume fraction along line  parallel to Y axis but in front of it (shown by green 
 line in Fig. (a)). 
 
--Comparison of particle volume fraction profiles along the lines parallel to Z 

direction and passing through probe slot: Fig. 4.33(a) shows the axes A, B and C 
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along which the volume fraction profiles for 100 micron and 400 micron particles are 

compared. The comparison is shown in Fig. 4.33 (b), (c) and (d). In each of the three 

cases along the slot of the probe it can be observed that volume fraction for 100 micron 

particles are more than the volume fraction of 400 micron particles. This is again due to 

the larger diameter of 400 micron particles which results in more apparent weight as 

apparent weight =  volume of particle x (density of particles-density of liquid) x 

gravitational acceleration. In the current cases, the only thing that is different for the two 

particles is the diameter on which the volume depends. Hence the particles with lesser 

diameter have greater volume fraction (Provided the same initial volume fraction). 

 

 

      (a) 



 100

 

                                (b)                                                                     (c) 

                     

                                                                      (d) 

 Fig. 4.33 (a) Axes. Comparison of volume fraction for different particle size along 
 (b) Slot line A, y/R= 0.69 (c) Slot line B, y/R= 0.625 (d) Slot line C, y/R=0.56.  
 

 It can be noticed that the results obtained for two different particle sizes are in 

good agreement with the findings of Hossain et al. (2003). They have discussed that the 

larger particle size will impart more settling tendency. As observed here, the particles 

with higher diameter shows lower volume fraction magnitudes along different axes in the 

probe sensing region (slot).  
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4.4 Comparison of the velocity profiles obtained for ADP and Xylene slurry to that 

of calcium carbonate and water slurry: It has been discussed previously that in a 

different case calcium carbonate particles were made to flow through water as the liquid 

medium. The axial (z) velocity profiles have been obtained for the slurry mixture flowing 

through the pipe of length 7.112m (L/D=70). A comparison has been made for the 

velocity profiles along different axes.  

 

 Fig. 4.34 Comparison of ADP and CaC03 particles Z velocity profile along 
 centerline of the pipe. (Probe vicinity shown between parallel lines with 0.09 < 
 Z/D < 0.09) 
 

The Z velocity along the centerline of the pipe for slurry of ADP particles with 

Xylene is compared with that of the slurry of calcium carbonate particles in water as 

shown in Fig.  4.34. The Z velocity profile for ADP particles is shown above the calcium 

carbonate particle profile. This shows that ADP particles are flowing with higher velocity 

along the centerline than the calcium carbonate particles even though all the conditions 

are same. These conditions include the particle size, inlet particle volume fraction, inlet 
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particle and liquid velocities. This behavior can be explained again by means of the 

buoyancy force applicable on ADP and CaC03 particles. It is a fact that buoyancy force 

results in the decrease in the actual weight of a body immersed in a liquid. Buoyancy 

force acting on the body, when subtracted from actual weight of the body results in 

apparent weight of the immersed body.  Thus, 

Apparent immersed weight = Actual weight-Buoyancy force  

The actual weight and buoyancy force in this case are directly dependent on the 

densities of particle and liquid (in which particle is immersed). The apparent weight will 

be directly proportional to the difference in the densities of particle and the liquid 

carrying it. In case of ADP and Xylene, difference of densities come out to be 610 

kg/m3(1480-870) while in CaC03 and water case it is 1800 kg/m3 (2800-1000). Thus 

difference in densities is more for the case of CaC03 and water. Therefore they will have 

more apparent weight. Due to this their Z velocity component will be suppressed. Hence 

they have lower Z velocity.  

 

 Fig. 4.35 Comparison of ADP and CaC03 particles Z velocity profile along the 
 axis parallel to the centerline and passing through the probe slot. (Probe  vicinity 
 shown between parallel lines with 0.09 < Z/D < 0.09) 
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 In Fig. 4.35 the comparison of Z velocity profiles along an axis parallel to the 

centerline and passing through the probe slot is shown. In this case also, a similar 

observation can be seen and hence the same reason holds good here also. Calcium 

carbonate particles being heavier will have lower Z velocity than ADP particles which 

are lighter.  

 

 Fig. 4.36 Comparison of Z velocity along the line through the center of the  probe 
 slot circular section in Y direction. (Probe slot lying between  0.5<y/R<0.75 
 

In Fig. 4.36, the Z velocity along the line through the center of the probe slot 

circular section in Y direction has been shown for ADP and calcium carbonate particles. 

As discussed above similar trend has been observed in this case also with the same 

reasoning. 

The results of velocity profiles obtained by Ling et al. (2001) shows the effects of 

density difference as they have used two different types of particles with different 
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densities. Similar observations are observed for the above velocity comparisons owing to 

density difference. Thus the results show agreement with the findings in the literature. 
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CHAPTER V 
 
 

CONCLUSIONS AND RECOMMENDATIONS  

 

5.1 Summary: 

 In the current research, a chemical slurry consisting of liquid Xylene flowing with 

ADP particles in a pipe has been considered primarily. Some cases of comparison of 

slurries of ADP-Xylene and CaC03-water are also considered. The length to diameter 

ratio of the pipe is 70. A geometric model of an FTIR/NIR probe is mounted 

asymmetrically on the wall of the pipe. Fluent (Ansys) has been employed as the 

simulation software to predict the end results of the flow. The K-ε  Turbulence model 

and mixture multiphase model are employed for analysis. Particle sizes of 100 and 400 

microns are considered and a comparative study is done based on variation in particle 

size.  

5.2 Conclusions: 

The following conclusions are drawn on the basis of results shown in the last chapter. 

1. For the plain pipe flow in the pipe with L/D=70, the profiles of axial velocity 

exhibit fully developed flow characteristics at about Z/D= 45. 

2. The axial velocity profile for the slurry of ADP and Xylene is computed for pipe 

with NO probe. It has been found that the centerline axial velocity becomes constant at
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about Z/D=35 and indicating fully developed flow takes place. Since fully developed 

characteristics are achieved at Z/D= 35, hence with a view to mount the probe/sensor 

in fully developed region, it is a good idea to mount the probe at a location of Z/D= 

40. 

 3. The axial velocity profiles of ADP particles in the pipe with probe mounted at Z/D= 

40 (from the entrance) are plotted along the centerline, an axis parallel to the 

centerline and passing through the probe sensing region (slot) and the axis parallel to 

centerline and passing through the probe solid part. 

a) Axial velocity profiles are found similar to the profiles for the plain pipe 

slurry flow in the entrance region of the pipe. 

b) Fluctuations in the axial velocity are observed in the probe vicinity which 

require further study. 

   4. Particle axial velocity and volume fraction along the axes through the probe sensing        

region (slot) in vertical Y direction and parallel to Y direction are analyzed.        

a) Particle axial velocity magnitudes observed along the axis passing through 

the probe slot (along y axis) are slightly higher than those for the axes from 

top to bottom across the gap to the left and right of the probe Y axis in the 

probe slot. 

b)  Volume fraction along these axes is very nearly constant. 

5. Volume fractions are compared along the axes in the front and behind the Y axis                       

passing through the probe sensing region (slot). The axis behind is near the probe   

slot vertical wall. Volume fraction is found to be nearly constant along the 

considered axes.  
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     6. Particle axial velocity profiles along the vertical axes at different axial locations 

along the length of the pipe have been computed for ADP-Xylene slurry. The results 

obtained show that the location of maximum velocity point rises as we move further 

downstream. The profiles are asymmetric. These results show agreement with the 

results in literature. 

7. Volume fraction profiles along the axes parallel to Z direction (axial direction)   

and lying in the sensing region (slot) of the probe are computed for ADP and Xylene 

slurry. The volume fraction variation is very small and volume fraction along the 

axial direction of probe sensing region (slot) may be considered constant. 

        8. The variation of volume fraction for two different particle sizes (100 and 400        

  microns) of ADP are compared along different axes in X, Y and Z directions in  

  the probe sensing region (slot). 

a) The volume fraction magnitude is found to be virtually constant along all the    

axes for both particle sizes. 

b) The magnitude of volume fraction for 100 micron particles is found to be 

somewhat higher than the volume fraction magnitude for 400 micron particles. 

This difference is believed to be due to the higher settling tendency of larger       

diameter particles and is in agreement with the literature. 

 9.   Particle axial velocity profiles for the flow of slurry of ADP particle and Xylene     

are compared with the flow of slurry of CaC03 and water along the three different 

axes. The magnitude of axial velocity profiles for slurry of ADP and Xylene is found 

higher than that for the flow of CaC03 and water slurry along all the three axes. This 
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is due to the higher density magnitude of CaC03 than ADP particles. This agrees with 

the results in the literature. 

 

5.3 Recommendations: 

 1.  In order to mount in the fully developed flow region the probe can to be mounted at 

Z/D= 40. Hence the pipe length after the probe for the computations can be reduced. 

This will result in the decrease in the number of cell volumes formed by meshing the 

geometry. Hence less computational power will be required for the analysis. 

 

2.  The influence of sphericity of the particles should also be modeled as all the particles 

may not be of the spherical shapes. 

 

3.   The discrete phase flow of the slurry of ADP particles and Xylene should be modeled 

and the results of should be compared with multiphase flow modeling. 
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APPENDIX 

Snapshots taken from FLUENT 6.3 

 

 

   Main pull down menu of FLUENT.  Version 3ddp stands for 3D-Double Precision.



 113

 

                

 

                                                         SOLVER MENU 
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  Selection of Turbulence model in FLUENT. Default values of model constants are used. 

 

                                      
                                                             
                                            Selection of Multiphase model. 
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                                                   MATERIAL PROPERTIES OF ADP 
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                                               MATERIAL PROPERTIES OF XYLENE 
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                                        DEFAULT PROPERTIES OF WATER. 
 
 
 



 118

   
                  
                                         DEFAULT PROPERTIES OF CaCO3
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